




















































































































































































































































































































































































































































































































































































































































































































IIIII Using Calendar 

Viewing Different Dates 

To change the date or month that is displayed, use the commands from the 
Show menu. These commands apply to dates when in the Day view, and to 
months when in the Month view. Table 2{}-2 describes how to scroll to view 
different dates. 

Table 20-2 Scrolling to View Different Dates 

To display... With the Mouse ... 

Current date or month Select the Today command 
from the Show menu 

Previous date or month Select the Previous com· 
mand from the Show menu 

Next date or month Select the Next command 
from the show menu 

With the Keyboard ... 

Press the Home key 

Press Ctrl/Pg Up 

Press Ctrl/Pg Dn 

Viewing Different Dates Using the Month View 

In the Month view, select the day for which you want to enter, edit, or 
display appointments. 

To display the Month view, use the Month command from the View menu or 
click on the date line. 

Table 20·3 describes how to move in the Month view and select with the 
mouse a day you want to view. 

Table 20-3 Moving in Month View With the Mouse 

To select ... 

Another day 

Next month 

Previous month 

Next year 

Previous year 

20-8 

Click on ... 

Desired day 

Scroll arrow at the bottom of the vertical scroll bar 

Scroll arrow at the top of the vertical scroll bar 

Gray area below the scroll box 

Gray area above the scroll box 



Using Calendar 

Table 20-4 describes how to move in the Month view and select with the 
keyboard a day you want to view. 

Table 20-4 Moving in Month View With the Keyboard 

To Select ... 

Next date 

Previous date 

Date directly below the current date 

Press ... 

Right arrow key 

Left arrow key 

Down arrow key 

IIIII 

If the current date is in the bottom row of the 
calendar, pressing the down arrow key selects 
the next month. 

Date directly above the current date Up arrow key 

If the current date is in the top row of the 
calendar, pressing the up arrow key selects 
the previous month. 

Next month 

Previous month 

Pg Dn key 

Pg Up key 

Once you select the day you want, you return to the Day view by double­
clicking on the selected day, pressing the Return key, or using the Day com­
mand from the View Menu. 

Viewing a Specific Date 

To display a specific date: 

1. Select the Date command from the Show menu. 

2. In the text box, type the date you want Calendar to display. 

3. Select the Ok command button. 

Calendar displays the date. 

You can type any date between January 1, 1980 and December 31, 2099. 
Type dates in the following format: mm/dd/yyyy or mm-dd-yyyy. You do not 
need to type leading zeros for days or months. 

NOTE 
You can specify the date format that is prevalent in your country 
through the Control Panel. 
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If you type a two-digit number for the year, Calendar assumes the 20th cen­
tury. Table 20-5 shows acceptable entries 

Table 20-5 Acceptable Entries for Dates 

Date Typed Representation 

January 19, 1985 

November 7, 1985 

January 1, 2010 

1/19/85 

11-7-85 

1/1/2010 

Customizing Your Calendar 

You can customize the Day view of your calendar with commands from the 
Options menu. For example, you can change the day settings or add notes to 
your appointments. 

Changing Day Settings 

The day settings control the display of the Day view. 

To change the day settings: 

1. Select the Day Settings command from the Options menu. 

Calendar displays the Day Settings dialog box. Figure 20-2 shows the 
Day Settings dialog box. 

Da, Settings 

Interval 015 039 @iB 
Hour Fomat @ 12 0 24 

Starting Tille: I 8: I18aM 
lOkI 
(Cancel ) 

Figure 20-2 Day Settings Dialog Box 

2. Select the options you want: Interval, Hour Format, or Starting Time. 

Interval controls the interval for daily appointments. You can select 15-
minute, 30-minute, or 60-minute intervals. 
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Hour Format represents the Calendar clock: a standard 12-hour clock or 
a 24-hour clock. 

Starting Time is the earliest listed time when the Day view is displayed. 

3. Select the Ok command button. 

Calendar changes the day setting to the option you specified. 

Using Special Times 

You can enter appointments for special times. A special time is any time that 
falls between the intervals set with the Day Settings command on the Options 
menu. For example, 11: 1 0 is a special time. 

Adding Special Times 

To add a special time: 

1. Select the Special Time command from the Options menu. 

Calendar displays the Special Time dialog box. 

2. Type the desired time in the text box. 

3. Select the Insert command. 

Calendar adds the new time. 

Deleting Special Times 

To delete a special time: 

1. Select the time you want to delete. 

2. Select the Special Time command from the Options menu. 

Calendar displays the Special Time dialog box with the selected time in 
the text box. 

3. Select the Delete command. 

Calendar deletes the selected time. 

20-11 



11111 Using Calendar 

Adding Notes 

The daily appointment window has a scratch pad, located at the bottom of 
the Calendar window, to which you can add notes. 

To add notes: 

1. Move the insertion point to the scratch pad area and click. 

To use the keyboard, press the Tab key. 

Calendar displays an insertion point. 

2. Type your notes. 

3. To return to the appointment area, move the insertion point. To use the 
keyboard, press the Tab key to move the insertion point. 

Calendar displays the notes in the scratch pad. 

Marking Dates 

You can mark dates in the Month view. For example, you can mark dates of 
special occasions. 

Marking a Date 

To mark a date in the Month view: 

1. Point to the date you want to mark and click, or press the arrow keys to 
move to the date. 

2. Select the Mark command from the Options menu. 

Calendar puts a small box around the number. 
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Unmarking a Date 

When a marked date is highlighted, the Mark command from the Options 
menu has a check mark next to it. 

To unmark a marked date: 

1. Select the date you want to unmark. 

2. Select the Mark command from the Options menu. 

Calendar removes the box around the number. 

Working With Calendar Files 

With commands from the File menu in the Calendar window, you can: 

• Open a file 

• View files in other directories 

• Save a file 

• Print a file 

• Remove appointment dates 

You delete Calendar files with commands from the File menu in the MS-DOS 
Executive window. 

Opening a File 

You can have many different Calendar files. For example, you can have two 
files to record two different people's appointments. 

Opening a New File 

To create a new calendar file, use the New command from the File menu. 
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Opening an Existing File 

You can open an existing file from either the Calendar window or from the 
MS-DOS Executive window. 

To open an existing file with the Open command: 

1. Select the Open command from the File menu. 

Calendar displays the Open dialog box. Directories and drives are 
enclosed in brackets. Figure 20-3 shows the Open dialog box. 

File naMl!: 

I Open] 

Cancel 

Figure 20-3 Open Dialog Box 

2. From the list of file names, select the file name you want to open, or 
type a path name and a file name in the text box at the top of the 
dialog box. 

You can also double-click on the file name you want to open. 

3. Select the Open command button. 

Calendar opens the specified file. 

To open an existing file from the MS-DOS Executive window, double-click on 
the file name you want to open or select the file name and press the Return 
key. Usually, these files have the file extension .CAL. 

MS-Windows starts Calendar and opens the file you selected in the MS-DOS 
Executive window. 
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Viewing Files in Other Directories 

Initially, Calendar displays only the names of the calendar files as well as 
drives and directories. You can view files, other than calendar files, in other 
directories or drives. 

To view files in other directories: 

1. Select the Open command from the File menu. 

Calendar displays the Open dialog box. 

2. In the text box, type the directory, drive, or file name you want to read. 
For example, you can type' .TXT to list all the files having the file 
extension .TXT. 

To move between directories, you can also double-click on the drive 
letter symbols, the directories, or the [ .. ] symbol. 

3. Select the Open command. 

Calendar lists the specified files. The Open dialog box remains on the 
screen until you open a specific file or cancel the command. 

Saving a File 

When you create a new file, or when you finish editing a file, you can save it 
and open it later. To save a command file, use one of two commands from 
the File menu: 

• Save As - Saves and names a new file 

• Save - Saves a current file 

20-15 



IIIII Using Calendar 

Saving a New File 

The Save As command names and saves a new file. It can also save the cur· 
rent file under a new file name and retain the original copy of the file on the 
disk under the old file name. 

To save a new file: 

1. Select the Save As command from the File menu. 

Calendar displays the Save As dialog box. Figure 20·4 shows the Save As 
dialog box. 

Saue file as: C: \lIindows 
..... IJOH=HS=ON:-::------,It Saue ] 

(Cancel ) 

Figure 20-4 Save As Dialog Box 

2. Type a file name for the file. If you do not type an file extension, 
Calendar adds .CAL to the file name. 

3. Select the Save command button. 

Calendar saves the file on the disk. The file remains on the screen so 
that you can continue editing it. Calendar displays the name of the file 
in the title bar of the Calendar window. 

NOTE 
If you type the name of a file that already exists, Calendar asks if 
you want to replace the existing file with the file you are saving. 
To replace the existing file, select the Yes command button. 
Otherwise, select the No command button and type a different file 
name. 
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Saving Changes 

To save changes to the current file, use the Save command from the File 
menu. 

Calendar replaces the file on the disk with the current file. 

Printing Appointments 

To print appointments: 

1. Select the Print command from the File menu. 

Calendar displays the Print dialog box. Figure 20-5 shows the Print dia­
log box. 

Print Appointments 

F r 0111: IlrMI,,:r;1 ( Ok ) 
To: ( Cancel) 

Figure 20-5 Print Dialog Box 

2. In the From text box, type the first date you want to print. 

3. Press the Tab key to move the cursor to the To text box. 

4. Type the last date you want to print. 

To print a single date's appointments, leave the To text box blank. 

5. Select the Ok command button. 

Calendar prints the text for the selected dates. 
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Removing Appointment Dates 

You can delete a single date or a range of dates to make room for other dates 
on your disk. 

To remove appointment dates: 

1. Select the Remove command from the File menu. 

Calendar displays the Remove dialog box. Figure 20-6 shows the 
Remove dialog box. 

Re",ove Appoint",ents 

Fro",: Inm I ( Ok ) 

To: '--_---'I (Cancd) 

Figure 20-6 Remove Dialog Box 

2. In the From text box, type the first date you want to remove. 

3. In the To text box, type the last date you want to remove. 

To remove a single date's appointments, leave the To text box blank. 

4. Select the Ok command button. 

Calendar removes the text for the dates you selected. 

Deleting a File 

You can delete a file to make room for other files on your disk. To delete a 
file, use the Delete command from the File menu. 
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Chapter 21 
Using Calculator 

The MS-Windows Calculator is a desktop application that works as a hand­
held calculator. It has many basic arithmetic functions and a memory. 

This chapter describes how to: 

• Start Calculator 

• Use Calculator 

Starting Calculator 

To start Calculator when it is neither in a window nor set aside as an icon in 
the icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start Calculator: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

CALC 

3. Select the Ok command button. 
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When you start Calculator, it creates a window with a calculator in it. Figure 
21-1 shows the Calculator window. 

Figure 21-1 Calculator Window 
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Using Calculator 

Calculator performs standard calculations. It also has access to the Clipboard. 

To use Calculator, point to the keys in the Calculator window and click. 

To use the keyboard, use the keys shown in Figure 21-2. You can type the 
digits 0 through 9 and the plus, minus, multiplication, division, and equal 
signs on the keyboard or on the numeric keypad. If you use the numeric 
keypad, the Num Lock key must be enabled. 

M and C 

M and R 

M and + 

M and-

Q 

% 

C 

Figure 21-2 Using Calculator With the Keyboard 

Using the Memory 

Calculator has its own memory, which initially is set to zero. You can add to 
or subtract from this value. You can also display or clear the memory. Table 
21-1 shows the mouse and keyboard procedures for using memory. 

Table 21-1 Using Memory With the Mouse and Keyboard 

To... With the Mouse ... 

Clear the memory Click on MC 

Display the value in memory Click on MR 

Add the displayed value to mem- Click on M+ 
ory 

Subtract the displayed value Click on M-
from memory 

With the Keyboard ... 

Press MjC 

Press MjR 

Press Mj+ 

Press Mj-
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Using the Clipboard 

You can use the Clipboard to copy numbers from other applications into the 
Calculator display, and from the Calculator display into other applications. 

Copying to the Clipboard 

To copy the displayed value to the Clipboard, use the Copy command from 
the Edit menu. 

Calculator copies the displayed value to the Clipboard. 

Copying from the Clipboard 

To add data from the Clipboard to the displayed Calculator value, use the 
Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Calculator adds the data from the Clipboard to the displayed Calculator 
value. If the Clipboard does not contain a number, Calculator does nothing. 
If the Clipboard contains a formula, that is, a legitimate series of calculatory 
entries such as 2X3-4, Calculator pastes the result of the formula. 
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Chapter 22 
Using Clock 

The MS-Windows Clock is a desktop application that acts as a standard clock 
and shows the current time. 

This chapter describes how to: 

• Start Clock 

• Set Clock 

Starting Clock 

To start Clock when it is neither in a window nor set aside as an icon in the 
icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start Clock: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

L 

3. Select the Ok command button. 
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When you start Clock, it displays a window that contains a clock. Figure 22-1 
shows the Clock window. 

- Clock :I 

•• • 

• • 

• • 

• • 
•• 

Figure 22-1 Clock Window 

Setting the Clock 

Clock displays the time from your hardware clock or the time you entered 
when you started your workstation. You can reset the Clock from the Control 
Panel. 

Clock continues to show the correct time even if you shrink it into an icon. 
When Clock is an icon, you can display the current time without using any 
of the screen's workspace. 
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Chapter 23 
Using Reversi 

MS-Windows Reversi is a desktop application that is a game you play with 
your workstation. To win Reversi, you try to finish the game with more 
squares of your color on the board than the workstation has of its color. 

This chapter describes how to: 

• Start Reversi 

• Follow the rules of Reversi 

• Play Reversi 

• Use Reversi's hints 

• Start a new game of Reversi 

Starting Reversi 

To start Reversi when it is neither in a window nor set aside as an icon in the 
icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start Reversi: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

EIJE!?SI 
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3. Select the Ok command button. 

When you start Reversi, it displays a window that contains the Reversi game. 
Figure 23-1 shows the Reversi window. 

E3 Revel'si • 

Figure 23-1 Reversi Window 

With a black and white screen, your squares are white; the workstation's 
squares are black. The following sections describe how to play Reversi using 
the black and white screen. 

Rules of the Game 

The rules of Reversi are: 

• You try to turn black squares white by trapping them between two 
white squares. To trap a black square, the three squares must form a 
straight line: horizontal, vertical, or diagonal. 

• If you can trap a black square, you must do so. 

• If you cannot move, select the Pass command from the Game menu. 

• When neither you nor the workstation can move, the game is over. 

The one with the most squares wins. 
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Playing Reversi 

To play Reversi: 

1. Select one of the four skill levels from the Skill menu. 

Skill levels range from Beginner, the easiest, to Master, the hardest. The 
higher the skill level, the longer your workstation spends calculating its 
moves. 

2. Point or press the arrow keys to move to a gray square. 

The mouse cursor displays as a cross when you can make a move. 

3. Click on the mouse button or press the spacebar to make your move. 

4. Wait for the workstation to make its move. 

The mouse cursor may change to an hourglass while the workstation 
calculates its move. 

Reversi Hints 

You can ask Reversi for hints. When you use the Hint command from the 
Game menu, Reversi shows you where it would move if it had your turn. 
You can accept the hint or move somewhere else. 

Starting a New Game 

You can start a new game at any time, even in the middle of the current 
game. 

To start a new game, use the New command from the Game menu. 
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Chapter 24 
Introducing MS-Paint 

This chapter describes: 

• MS-Paint 

• Preliminary information 

• Paint definitions 

Defining MS-Paint 

MS-Paint is a drawing tool designed for use with MS-Windows. With MS-Paint, 
you can create, enhance, save, and print artwork. 

MS-Paint helps you create art that best suits your needs. Whether you create 
flow charts or freehand illustrations, you can find all the tools you need on 
MS-Paint's tools and shapes palette. Special commands such as Zoom In, 
Copy, and Invert let you enhance your work. You can transfer text and graph­
ics from other programs to MS-Paint for alteration and enhancement, or cre­
ate MS-Paint graphics to use in other applications such as Cardfile. 

You don't need to memorize complex commands or instructions. With MS­
Paint, you can create art quickly. Although MS-Paint is designed for use with 
a mouse, you can use it with the keyboard. For more information on using 
the keyboard, see Appendix F. 

Preliminaries 

Before using MS-Paint, you should become familiar with your workstation, its 
operating system, and MS-Windows. 
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Definitions 

The following definitions are helpful for learning MS-Paint: 

• The canvas is the area available for a drawing. It matches the maximum 
printable surface area of your printer or display device. Figure 24-1 
shows an MS-Paint canvas for a printer in portrait mode. 
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Paint - HORSU1SP' v • 

_______ 1 ______ _ 

Icanvas 
Figure 24-1 MS-Paint Canvas 

Figure 24-2 shows an MS-Paint canvas that is displayed on your screen. 
This canvas is called the MS-Paint window. 
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Current status box 
Tool 

i Paint pattern 

i I Tools and shapes palette 

Brush shape 
Drawing window 

Punt - HORSE.MS 

I 
Title. bar 

I Menu bar 
i 

I l--~ 

Figure 24-2 MS-Paint Window 

• The drawing window frames the portion of a canvas that is displayed on 
the screen. 

• The title bar contains the title of your canvas. 

• The menu bar contains the names of MS-Paint's command menus. 

• The tools and shapes palette contains the implements for drawing and 
refining your artwork. 

• The current status box shows the tool, paint pattern, brush shape, and 
line width that MS-Paint uses when you draw. 

• The mouse cursor selects menus, commands, tools, and shapes. The 
mouse cursor changes shape in the drawing area whenever you select a 
tool or a shape. 
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Chapter 25 
MS-Paint Tools 

and Shapes Summary 

This chapter describes: 

• The functions of MS-Paint's tools 

• The functions of MS-Paint's shapes 

This chapter shows the icons for the tools and shapes that are located in the 
tools and shapes palette. You use these icons to follow the procedures in 
Chapter 26 and Chapter 27. 
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Tools 

~ Selection 
U Rectangle 

Defines a rectangular area 
for editing. . ... .. 

l 
I" 1 Selection 

Net 

Defines a nonrectangular 
area for editing. /~ 

. /r'l,~ .... 
,L.J . 
"-----------/ 

ITI Text 

Enters text in the selected 
font, size, and style. 

~ ANTIQUE 
TOY 

COMPANY 

I~I Fill 

Fills an enclosed area with 
the current pattern. 

25-2 

1+1 Scroll 

Slides the canvas under the 
drawing window. 

rn Pencil 

Draws a thin line . 

Eraser 

Erases the features of a draw­
ing along the pointer path. 

1001 Curve 

Creates a curved line. 

Vl 
L-J Line 1"-."/ ... 
I_f ! Brush 

Paints in the current pattern. 

[i] 3-D 

Displays axes to follow when 
creating 3-D drawings. 

1 fi:'1 Airbrush 

Sprays paint in the current 
pattern. 



Shapes 

IDI Box 

Draws a box with square 
corners. 

1 0 1 Rounded 
Box 

Draws a box with rounded 
corners. ~/1I1I1I1I1I1I1I1/1/l11I1"1J1I1I/~ 

~ - -"". ~ 
~11""I""I""""t"/j 

101 Circle 

Draws a circle. 

-:-

MS-Paint Tools and Shapes Summary IIIII 

10 1 Oval 

Draws an oval. 

-:-(~n 

Gl:!-0 
rcr Freehand 
~ Polygon 

Draws shapes that are closed 
with a straight line upon 
release of the mouse button. 

16.1 Polygon 

Draws a polygon. 
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Chapter 26 
Getting Started 
With MS-Paint 

This chapter contains the information you need to: 

• Start MS-Paint 

• Draw with MS-Paint 

• Save a canvas 

• Use MS-Paint's palettes 

• Print a canvas 

• Finish MS-Paint 

Starting MS-Paint 

To start MS-Paint when it is neither in a window nor set aside as an icon in 
the icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start MS-Paint: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

p~\ I NT 
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3. Select the Ok command button. 

MS-Paint creates an untitled canvas and opens the drawing window 
over it. 

Before you begin drawing, if you intend to print your canvas, select the For 
Printer command from the Options menu. If this command is not selected, 
you will not be able to print any of your screens. The canvas is intended for 
the printer that is the default when you create the canvas. 

You can print on other printers, but the output may look different. 

Select the For Screen command from the Options menu if you have no 
printer, no printer is selected, you only want to display the drawing, or you 
want to transfer the canvas to other MS-Windows applications. 

Once you select a For Printer or For Screen command, you cannot change the 
setting unless you use the New command from the File menu. 

Drawing 

You draw by selecting the drawing tools from the tools and shapes palette. 
The default tool, the Pencil, draws thin lines for sketches. The Brush paints 
an area with the current pattern. You erase segments of your drawing with 
the Eraser. 
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Drawing With the Pencil 

To use the Pencil: 

1. Select the Pencil from the tools and shapes palette if it is not the cur­
rent tool. 

The Pencil is displayed in the current tool status box. 

2. Drag the Pencil within the drawing window to sketch. 

Figure 26-1 shows an example of the Pencil drawing Old Man Winter. 

Pencil cursor 

Figure 26-1 Drawing With the Pencil 
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Drawing With the Brush 

To draw with the Brush: 

1. Select the Brush from the tools and shapes palette. 

The Brush is displayed in the current tool status box. 

2. Drag the mouse cursor within the drawing window to draw. 

Figure 26-2 shows an example of the Brush giving Old Man Winter dark hair. 

Brush cursor 

Figure 26-2 Drawing With the Brush 
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Using the Eraser 

You erase mistakes and parts of the drawing that you no longer want with the 
Eraser. 

To use the Eraser: 

1. Select the Eraser from the tools and shapes palette. 

The Eraser is displayed in the current status box. 

2. Drag the mouse cursor within the drawing window to erase. 

Figure 26-3 shows the Eraser erasing some of Old Man Winter's hair. 

Eraser cursor 

Figure 26-3 Using the Eraser 
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Saving a Canvas 

The Save As command saves the contents of your canvas. 

To save your canvas: 

1. Select the Save As command from the File menu. 

A dialog box prompts you to name your canvas. The text box is empty 
when your canvas is untitled. 

Figure 26-4 shows the Save As dialog box. 

Save File As: C:\windows 

I I ( $iIVi! ) 

(Cancel ) 

Text box 

Insertion p oint 

Figure 26-4 Save As Dialog Box 

2. Type a name for your canvas. MS-Paint adds the file extension .MSP if 
you don't provide one. 

3. Select the Save command button. 

MS-Paint writes the contents of your canvas to your disk. 

Once you have created MS-Paint files that have the file extension .MSP, you 
can start MS-Paint by double-clicking on the file name in the MS-DOS Execu­
tive window. This loads both MS-Paint and the file. 
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Using MS-Paint's Palettes 

To specify patterns, line widths, and brush shapes in MS-Paint, select options 
from the Palette menu. 

For example, to change the current MS-Paint pattern: 

1. Select the Patterns command from the Palette menu. 

The pattern palette is displayed in the drawing window and highlights 
the current pattern. 

Figure 26-5 shows the patterns palette. 

PaInt - (untitled) • 

•••• ~mmDrm~ 
D r:::::::l~r71717IrTTlrmlWiJ~m 

I.:.:w:JliiiiiiiiaiJrlULiJWI.U.I~ll..lJI~ 

•• mm[!]D~~ LW 
D[]]§§Drltl~ 1m 

Patterns palette Current pattern 

Figure 26-5 Patterns Palette 

2. Select the pattern you want. 

The pattern palette vanishes, and the new pattern is displayed in the 
current pattern status box. 

Once a palette is displayed on the screen, you must make a selection before 
you can return to your canvas. If you decide not to change the selection, 
select the item currently highlighted. 
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Printing a Canvas 

To print an MS-Paint canvas: 

• Your primer must be connected and turned on. 

• The For Printer command from the Options menu must be selected 
when you start MS-Paint, indicating that the printer is connected. 

To print your canvas, select the Print command from the File menu. MS-Paint 
prints the canvas on the printer. 

Finishing MS-Paint 

The System menu's Close command finishes an MS-Paint session and closes 
the drawing window. 

To finish an MS-Paint session: 

1. Select the Close command from the System menu. 

If your canvas has changed, MS-Paint displays a dialog box. 

2. Specify whether you want to save the changes before quitting. 

When MS-Paint quits, you are returned to the applications directory in MS­
Windows. 
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Chapter 27 
Creating a Drawing 

This.chapter describes how to: 

• Add shapes, text, and patterns to your canvas 

• Use MS-Paint's selection tools 

• Use several of MS-Paint's editing commands 

Drawing a Box 

To draw a box: 

1. Select the Box tool from the tools and shapes palette. 

The Box is displayed in the current status box. 

2. Point to the drawing window. 

The mouse cursor is displayed as a cross. 

3. Hold down the mouse button to mark a corner, then drag the cross 
diagonally to create the box. 
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Figure 27-1 shows a box with the Box mouse cursor. 

I 
-I-

I Box cursor 

Figure 27-1 Box 

Drawing Other Shapes 

Table 27-1 describes how to use the tools that draw other shapes. 

Table 27-1 Tools for Drawing Shapes and How to Use Them 

Tool 

Line 

3-D 

Curve 

Airbrush 

Rounded Box, 
Circle, Oval 

Freehand 
Polygon 

Polygon 
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Procedure 

Drag to draw straight line segments. 

Drag along the axes that create shapes with a three-dimensional ap­
pearance. 

Draw a line segment, then click to the side of it. MS-Paint turns the 
segment into a curve. 

Drag to spray paint in the current pattern. 

Drag to draw the shape. 

Drag to draw. MS-Paint closes the image with a straight line when 
you release the mouse button. 

Click to mark the corners of the image. MS-Paint draws the lines. 
Double-click on the final corner. 
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Adding Text 

The Text tool adds text to a drawing. The text's display is determined by the 
selected commands from the Font and FontSize menus. 

To add text: 

1. Select the Text tool from the tools and shapes palette. 

The Text tool is displayed in the current tool status box. 

2. Point to the drawing window. 

3. Click to mark where you want your text to begin. 

4. Type the desired text. 

Figure 27-2 shows the heading LEGEND, which labels a legend box. 

LEGEND 

Figure 27-2 Box with Text 
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Adding Patterns 

The Fill and Filled Box tools add symbolic patterns to a drawing. 

Drawing a Filled Box 

To create a filled box: 

1. Select the Patterns command from the Palette menu. 

2. Select a pattern for the filled box. 

The pattern is displayed in the current status box. 

3. Select the Filled Box tool from the tools and shapes palette. 

The Filled Box is displayed in the current status box. 

4. Draw a box. 

The pattern fills the box when you release the mouse button. 

Figure 27-3 shows a filled box that is drawn and labeled to represent rain. 

LEGEND 

Wjrain 

Figure 27-3 Filled Box 
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Filling a Shape 

To fill a shape: 

1. Select the Patterns command from the Palette menu. 

2. Select a pattern to fill the shape. 

The pattern is displayed in the current status box. 

3. Select a tool from the tools and shapes palette to draw the shape. For 
example, you can select the Box or the Polygon tools. 

The tool is displayed in the current status box. 

4. Draw a shape. 

5. Select the fill tool from the tools and shapes palette, place the tip of 
the pouring paint in the empty shape, and click on the mouse. 

The pattern fills the shape when you release the mouse button. 

Figure 27-4 shows a box that is labeled and filled to represent hail. 

Fill cursor 

LEGEND 

hail 

Figure 27-4 Filling a Shape 
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Editing a Selection 

You can edit a selection of a drawing. The following sections describe how 
to select part of a drawing, and how to edit with special effects and in detail. 

Making a Selection 

To edit a drawing, you must define areas of your canvas with the Selection 
Rectangle and the Selection Net tools. 

To select an area of a drawing: 

1. Select the Selection Rectangle tool or the Selection Net tool from the 
tools and shapes palette. 

2. Drag the cursor to enclose a selection of your drawing. 

The selected area is enclosed within a box if you are using the Selection 
Rectangle tool. The selected area is enclosed within a net if you are 
using the Selection Net tool. 

Figure 27-5 shows a selected butterfly wing . 

. ________ .l ~~I_ection rectangle 

I ' 
....... - ........ - ...... I ~I:! 

LI. 

Figure 27-5 Selection Rectangle 
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Copying a Selection 

Once you select an area of the canvas, you can copy it to the Clipboard, 
leaving the original still displayed. After you paste the area back to the can­
vas, you can move it to where you want. 

To copy a selection: 

1. Select the Copy command from the Edit menu. 

The selected area is copied to the Clipboard. 

2. Select the Paste command from the Edit menu. 

The Clipboard contents are copied to the canvas inside a Selection 
Rectangle. 

The mouse cursor changes to an arrow, indicating that you can drag the 
selection. 

3. Drag the Selection Rectangle inside the drawing window, then release 
the mouse button. 

Editing With Special Effects 

The special effects commands from the Edit menu enhance a selected area of 
your drawing. 

For example, the Flip Horizontal command mirrors the selected area. For 
descriptions of other special effects commands, see Chapter 26. 

To mirror and paste a selection: 

1. Select an area or object. 

2. Select the Flip Horizontal command from the Edit menu. 

The selected area, still enclosed in the Selection Rectangle, flips from 
left to right. 

3. Drag the selected area into position. 

4. Move the cursor out of the Selection Rectangle, then click the mouse 
button. 

The Selection Rectangle disappears, and the copy is pasted to your 
canvas. 
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Figure 27-6 shows a butterfly wing that is selected and mirrored. 

Click the mouse button outside the Selection Rectangle to paste the copied 
wing in place. 

Selected wing after Flip Horizontal 

S""t~~ ~;-"-g-h ____ ~~~~:~~ __ 
: : I : 1 
, : 1 'I 

: I I 
: 1 1 
: I I 
: I 1 

- ..... -;1 1 
: 1 1 

'_ - - - - - - - - - - - - _: 1 , I 
I .......................... _I 

Figure 27-6 Results of the Flip Horizontal Command 

Editing in Detail 

To perform detailed editing on a part of your drawing, use the Zoom In 
command and the Pencil. 

To edit a drawing in detail: 

1. Select the Pencil, then click to mark where you want to edit. 

The Pencil makes a mark at the point where you click. 

The mark is white if you click on a black area; it is black if you click 
on a white area. 

2. Select the Zoom In command from the Options menu. 

MS-Paint zooms in to where you last released the mouse button. This 
view of the screen is called a zoomed-in drawing window. 
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3. Click to remove or add paint. Drag to make larger changes. 

The results of your editing appear in the upper-left corner of your 
canvas. 

Figure 27-7 shows an example of editing in detail. 

Zoomed-in drawing window 

Palnt - CPBUTTER.t-1SP • 

Figure 27-7 Editing in Detail 

4. When you are finished editing, select the Zoom Out command from the 
Options menu. 

The regular drawing window is displayed again. 
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Scrolling the Canvas 

The Scroll tool can: 

• Move the canvas under the drawing window 

• Copy a selected area of a drawing to another part of the canvas 

To scroll to a lower area of a canvas: 

1. Select the Scroll tool from the tools and shapes palette and move the 
tool to the bottom of the drawing window. 

2. Drag the Scroll pointer upward. 

The original area of the canvas scrolls up as the lower part of the canvas 
is displayed. 

The mouse cursor is displayed whenever MS-Paint adjusts the window 
display. 

Figure 27-8 shows a butterfly that is scrolled to reveal the lower part of the 
canvas. 

I Scroll cursor 

Figure 27-8 Scrolling the Canvas 
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Chapter 28 
MS-Paint 

Command Summary 

The MS-Paint commands that help you create, illustrate, and edit your can­
vasses are displayed in menus. You access menus through the menu bar near 
the top of the MS-Paint window. 

This chapter describes the command menus in the order they are displayed 
in the menu bar: 

• File 

• Edit 

• Font 

• FontSize 

• Style 

• Palette 

• Options 

File Menu 

The File menu commands create, save, and print your canvasses. Figure 28-1 
shows the File menu commands. Table 28-1 describes the commands. 
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tiew 
Open. 
Save 
Saue As. 
Pt·int 

Figure 28-1 File Menu 

Table 28-1 File Menu Commands and Descriptions 

Command Description 

New Clears the drawing window, then opens a new canvas. The status of 
the selected tool, pattern, brush shape, and line width is 
unchanged. 

Open Opens the drawing window over a previously created canvas. The 
status of the selected tool, pattern, brush shape, and line width is 
unchanged. 

Save 

Save As 

Print 

A dialog box prompts you to either select a title from the list box 
or type the title of the canvas you want. 

Saves the current canvas on disk under the existing name. This 
command prompts you for a name if the file is untitled. 

Saves the current canvas on disk. You can save either new, untitled 
canvasses or a new version of a canvas under a different name. The 
original version remains unchanged. 

Prints the canvas. The Print command is disabled if you have not 
installed a printer through the Set-Up program or on the Control 
Panel, or if you selected the For Screen command from the Options 
menu. 

Both the Open and New commands let you save any changes to the current 
canvas before proceeding. 
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Edit Menu 

The Edit menu commands let you edit a canvas. Figure 28-2 shows the Edit 
menu commands. Table 28-2 describes the commands . 

Undo . "'1 1 

,~:r"': !~.~;: 

ErCS2 

Cut 7~ : 

:}~ t 
Copy F:;? 

• b .... 

PCSt2 l Y·I~ 
.. ~: .~A 

Cl2cr 

I ilV2rt 
TrCC2 Ed92S 
F lip Horizontcl 
F lip V2rt; co l 

Figure 28-2 Edit Menu 

Except for the Erase, Undo, and Paste commands, all of the Edit menu com­
mands require that you first select what you want to edit. The Selection 
Rectangle or the Selection Net tools select an area. The Paste command is 
disabled if the Clipboard is empty. 
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Several commands in the Edit menu are disabled until you select an area for 
editing. 

Table 28·2 Edit Menu Commands and Descriptions 

Command Description 

Undo Cancels the most recent drawing action or series of editing actions 
performed on a selected area. Selecting Undo a second time restores 
these actions. 

Erase Erases the contents of the drawing window. 

Cut 

Copy 

Paste 

Clear 

Invert 

Trace Edges 

Flip 
Horizontal 

Flip Vertical 
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You can also double-click on the Eraser to erase the drawing 
window. 

Removes selected material from the canvas, and places it on the 
Clipboard. 

Copies selected material to the Clipboard. 

Copies the Clipboard contents into a selection box on the drawing 
window. The items you paste remain selected (and movable) until 
you click outside the selected area, make another selection with the 
Selection Rectangle or the Selection Net, or begin to draw again. 

You can paste the contents of the Clipboard as many times as YOll 

want. 

Erases the selected item from the drawing window. 

Ch'lnges the appearance of the selected area. This command 
changes a black area to white, and a white area to black. 

Traces the edges of the patterns, text, and shapes within a selected 
area. This command acts on selections made with the Selection Rec­
tangle tool. 

Flips the selected area from left to right. This command acts on 
selections made with the Selection Rectangle tool. 

Flips the selected area from top to bottom. This command acts on 
selections made with the Selection Rectangle tool. 
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Font Menu 

The Font menu contains the commands that select the text typeface. The Font 
menu commands vary according to the fonts installed for your system. 

You can change the typeface of a text sequence until you click again within 
the drawing window or select another tool. 

FontSize Menu 

The FontSize menu sets the size of your text. The FontSize menu commands 
vary according to the font sizes installed for your system. 

You can change the font size of a text sequence until you click again within 
the drawing window or select another tool. 

Style Menu 

The Style menu commands modify the appearance of text. Figure 28-3 shows 
the Style menu commands. Figure 28-4 shows the Style menu typefaces. 
Table 28-3 describes the other Style menu commands. 

Plain is the default typeface. 

You can change the style of a text sequence until you click again within the 
drawing window or select another tool. 
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28-6 

I" Plain 
Bold 
Italic 
Underline 
Outline 
Strikeout 

"Align left 
Align center 
Align right 

" Opaque 
Tt'anspat'ent 

FS 
F6 
F7 
F8 

Figure 28-3 Style Menu 

Plain Unaerline 

Bold 

Italic StriKee~t 
Figure 28-4 Style Menu Typefaces 
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Table 28-3 Style Menu Commands and Descriptions 

Command 

Align Left 

Align Center 

Align Right 

Opaque 

Transparent 

Description 

Aligns rows of text using an invisible column in the drawing 
window as a left margin. Your text moves to the right as you type. 
This is a default setting. 

Click on the text pointer to mark the location of the invisible 
column. 

Centers text evenly on both sides of the invisible column. 

Aligns text using the column as a right margin. Your text moves to 
the left as you type. 

Provides a solid white background for text. This is a default setting. 

Lets the current background pattern show through text. 

Figure 28-5 shows examples of the Align Left, Align Center, and Align Right 
commands. 

I Invisible column 

I 

~lignea left 
I 

. I 

al1gne~ center 
I 

alignea right 
I 

1 

I Text cursor 

Figure 28-5 Example Align Commands 
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Palette Menu 

The Palette menu commands select: 

• Paint patterns 

• Line widths for shapes 

• Brush shapes 

Figure 28-6 shows the Palette menu commands. 

Pcttl2rns . .. . 
Linl2 Widths .. . 
Brush Shcp~s .. . 
Too ls . .. 

Figure 28-6 Palette Menu 

The Tools command selects MS-Paint's tools when they are concealed by 
another drawing window. 
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Options Menu 

The Options menu commands: 

• Control the alignment and placement of your drawings, 

• Edit with greater detail 

• Enhance the display of patterns in the patterns palette for the current 
session 

Figure 28-7 shows the Options menu commands. Table 28-4 describes the 
commands. 

ZOOM In .~? 

ZOOM Out " ,., 
: '.) 

vNo Grid 
FinQ Grid 
MCldiuM Grid 
CocrsCl Grid 

Edit PClttClrn . .. 
", p}'"1 n';~ ~( .. :" :;;r' 
r· ~;t S:::t·~~n 

Figure 28-7 Options Menu 
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Table 28-4 Options Menu Commands and Descriptions 

Command Description 

Zoom In Zooms in on your canvas at the point where you last released the 
mouse button. Zoom In also returns a zoomed-out drawing window 
to its normal size. 

Zoom Out 

No Grid 

Fine Grid, 
Medium Grid, 
Coarse Grid 

Edit Pattern 

For Printer 

For Screen 
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MS-Paint's zoomed-in drawing window has a view finder in the 
upper-left corner. You view the effects of magnified editing on your 
canvas in this area. 

You can also double-click on the Pencil to zoom in or return from a 
zoomed-in drawing window to the normal drawing window. 

Displays the entire canvas with the current drawing window 
outlined. Zoom Out also returns a zoomed-in drawing window to its 
normal size. 

You can also double-click on the Scroll tool to zoom out to the full 
canvas or return from the full canvas to the normal drawing 
window. 

Turns off any active grid. This is the default setting. 

Lay an invisible grid on the drawing window. These commands let 
you align shapes and lines. 

Opens a dialog box to allow revision of the current MS-Paint 
pattern. 

Informs MS-Paint that the canvas is targeted for the default 
MS-Windows printer. 

Informs MS-Paint that the canvas is targeted for the screen. 
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Index IIIII 

8-20, 

8-5 

8-14, 

8-5 
8-20, 

8-20, 

changing printer connections 8-14 
changing printer port connections 

8-14 
changing screen colors 8-20 
changing time 8-3 
defined 8-1 
deleting fonts 8-6 
deleting printers 8-6 
dialog box 8-3 
in Cardfile 20-2 
in Clock 22-2 
running 8-1 
window 8-3 

CONTROL.EXE 8-2 
Controls command 20-6 
Copy command 2-17, 3-6,4-4, 4-5, 
4-6,5-4,7-7,7-8, 18-5, 18-8, 19-11, 
19-12, 19-13, 20-4, 21-4, 27-7, 28-4 

COpy command 32-24, 34-14 
Copying 2-16 

in Cardfile 19-14 
files from remote node 34-7 
files to hard disk 31-10 
files to remote node 34-8, 34-19 
files 4-4, 4-5, 4-6 
selection E-l 
system files to hard disk 31-9 
text 

in Calendar 20-4 
in Cardfile 19-11 
in Notepad 18-8 

Index-5 
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to the Clipboard 7-8 
VT220 emulator 10-4 

Country codes G-l 
COUNTRY command 1-5 
Country keyboards G-7 
Country settings command 8-20, 8-25 
Create command 28-1 
Create Directory command 3-9, 5-4 
Creating 

batch file 37-2 
card files 19-3 
characters A-I 

Compose key A-3 
compose sequence A-I 
Ctrl/Alt procedure A-I, A-2 
Ctrl/Alt/left-Shift procedure 

A-I, A-2 
three-key compose sequence 

A-I, A-3 
two-key compose sequence A-I, 
A-3, A-4 

multiple copies E-1 
PIFs C-4 

Ctrl key E-1 
Ctrl/Alt procedure A-I, A-2 
Ctrl/Alt/left-Shift procedure A-I 
Ctrl/Alt/Shift procedure A-2 
Ctrl/Arrow keys 6-2 
Ctrl/Break keys 6-2, 6-11 
CTTY command 32-31 
Current directory 3-3, 5-1, 30.4 
Current status box 24-3 
Cursor blink rate 8-5 
Cursor 3-3 
Curves F-2 
Customizing 

in Calendar 20-10 
Cut command 2-17, 18-5, 18-8, 

19-10, 19-11, 19-13,20-5,28-4 

D 
Data diskette 5-8 
Data 

ASCII 34-6, 34-7 
binary 34-6, 34-7 

Date command 20-9 
DATE command 32-32 
Day command 20-3 
Day Settings command 20-10 

Index-6 

Day Settings dialog box 20-10 
Day settings 

changing 20-10 
Day view 20-2, 20-9 
DEBUG 39-1 
DEBUG commands 

ASSEMBLE 39-3 
COMPARE 39-6 
DUMP 39-8 
ENTER 39-10 
FILL 39-13 
GO 39-15 
HEX 39-17 
INPUT 39-18 
LOAD 39-19 
MOVE 39-21 
NAME 39-23 
OUTPUT 39-26 
PTRACE 39-27 
QUIT 39-29 
REGISTER 39-30 
SEARCH 39-33 
TRACE 39-35 
UNASSEMBLE 39-37 
WRITE 39-39 

DecInfo section B-24 
DecKeybd section B-22 
DecLAT section B-21 
DECnet-VAXmate 

utilities NFT 34-1 
Default printer 8-15 
Definitions 

canvas 24-2 
current status box 24-3 
drawing window 24-3 
menu bar 24-3 
mouse cursor 24-3 
MS-Paint 24-2 
terminal emulator 9-1 
title bar 24-3 
tools and shapes palette 24-3 

DEL command 32-34 
Delete command 3-6,4-4,4-6,5-7, 

18-15,19-14,20-18 
DELETE command 34-20 
Delete Font command 8-6, 8-13 
Delete Printer command 8-6, 8-10 
Deleting files 4-6, 4-7 
Deleting 



cards in Cardfile 19-14 
files 

in Calendar 
in Cardfile 
in Notepad 

fonts S-13 

20-1S 
19-19 
IS-IS 

NFT files 34-20 
text 

in Calendar 
in Cardfile 
in Notepad 

Delimiters 30-2 
Destination drive 
DEVICE command 
Devices 

drivers 

20-5 
19-10 
lS-7 

30-3 
1-6 

characteristics 29-1 
logical 33-5 
physical 33-5 
section B-26 

Diacritical marks A-4 
Dialog box 

check boxes 1-12 
closing 1-12 
command button 1-10 

Cancel 1-12 
default 1-12 
keyboard procedure 6-11 
Ok 1-12 
Reset 1-12 

defined 1-8 
insertion point 1-11 
keyboard procedure 6-10, 6-11 
list box 1- 1 1 
option buttons 1-11 

keyboard procedure 6-10 
System menu box 1-12 
text box 1-10 

DlR command 32-35 
Directly Modifies option C-9 
Directories 5-1 

change listing 5-5 
changing 5-1, 5-3 
creating 5-4 
current 3-3,5-1,30-4 
defined 5-1, 30-4 
deleting 5-7 
displaying information 34-21 
displaying multiple 5-6 

Index 11111 

hierarchical 30-4 
listing 3-3,5-1,5-5 
MS-DOS Executive window 5-1 
path name 5-1 
printing listings 5-6 
printing 5-6 
root 30-4 
structure 30-4 
subdirectory 5-1 

DIRECTORY command 34-21 
Disconnecting 

from a remote directory 33-12 
from a remote printer 33-12 
from a resource 33-12 

DlSKCOPY command 32-37 
DlSKCOPY.COM 3-15 
Diskettes 5-S, H-1 

data 5-S 
formatting H-1 
preparing 5-S, 5-9 
system 5-9 
using H-1 

Disks 5-1 
displaying 5-11 
drive AS-II 
drive H 5-11 
naming 5-10 

Displaying 
disks 5-11 
multiple directories 5-6 
VT240 character attributes 16-1S 

Fast Text Only mode 16-1S 
VT240 line attributes 16-17 

Fast Text Only mode 16-17 
Text & Graphics mode 16-17 

Double-click on 
action defined 1-3 

Double-click 3-15 
rate S-5 

Drag 
action defined 1-3 

Drawing 26-2 
3-D 27-2 
box 27-1 
brush 26-4 
circle 27-2 
curve 27-2 
curves F-2 
eraser 26-5 

Index-7 
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filled box 27-4 
lines F-2, 27-2 
oval 27-2 
pencil 26-3 
polygons F-2 
rounded box 27-2 
shapes F-2 
window 24-3 

Drive icons 3-3 
Drop-down menu 1-7 
DUMP command 39-8 
Duplicate command 19-14 

E 
Early ring text box 20-6 
ECHO command 32-39 
Edit menu 18-5, 18-13, 19-10,28-3 

commands 28-3 
Clear 28-5 
Copy 28-4 
Cut 28-4 
Erase 28-4 
Flip Horizontal 28-5 
Flip Vertical 28-5 
Invert 28-5 
Paste 28-4 
special effects 28-5 
Trace Edges 28-5 

Edit Pattern command 28-11 
Editing 

a selection 27-6 
detailed 27-8 
in day view 

in Calendar 20-3 
in Notepad 18-5 
keys 36-1 
PIF C-5 
special effects 27-7 
text 

in Calendar 
in Cardfile 

EDLIN command 
Emulators 

20-4 
19-8 
32-41 

comparison table 9-2, 10-1 
ReGIS graphics 14-1 

DECgraph 14-1 
DECslide 14-1 

SETHOST command 9-1 
VT220 emulator 9-1 

Index-8 

VT240 emulator 9-1 
End key 7-5 
End Session command 3-9,3-15 
ENTER command 39-10 
Entering 

appointments in Calendar 20-3 
VT220 Set-Up 12-1 

F3 (Set-Up) 12-2 
Set-Up command 12-2 

VT240 Set-Up 16-1 
Erase command 28-4 
ERASE command 32-42 
Eraser 26-5 
ESC key 6-2, 6-5 
EXE2BIN command 32-43 
EXIT command 32-45, 34-23 
Exiting 

MS-Windows 29-5 
Set-Up selections 

Exit VT240 16-9 
standard applications 3-15 
VT220 Set-Up 12-5 
VT240 emulator 14-4 
VT240 Set-Up 16-5 
VT240 

Ctrl/FlO 15-1 
15-1 

1-3 
Exit key 

Expand defined 
Extensions section 
External commands 

B-8 

characteristics 29-1 
with MS-Windows 29-2 

F 
Fast Text Only mode 

viewing columns 
Shift/left arrow 
Shift/right arrow 

FC command 32-46 
FCBS command 1-7 

16-17 
16-17 

16-17 

FDISK command 32-49 
File menu 3-4,3-5,3-6,4-4, 18-10, 

18-12, 18-13, 18-14, 19-14, 19-16, 
19-17,26-8,28-1 

commands 3-6, 28-1 
NEW 28-2 
OPEN 28-2 
Print 28-2 
Save As 28-2 



Save 28-2 
File names 6-6 

characters in 30-8 
illegal 30-8 
keyboard procedure 6-8 

File specifications 
foreign 34-5 
remote 34-5 

FILES command 1-8 
Files 4-1 

appending 34-11 
batch 3-13 
canceling selected files 6-14 
canceling selected 4-2 
concatenating 4-6 
copying 4-4, 4-5, 4-6, 34-14 
defined 4-1 
deleting 4-6,4-7,34-20 
displaying contents 34-29 
extension 

defined 3-6 
View menu 3-8 

in Calendar 20-13 
in Cardfile 19-14 
in Notepad 18-10 
keyboard procedure 6-14 
listing 5-5 
name 7-6 
naming 4-1,30-7 
printing 4-7, 34-25 
renaming 4-12 
selecting multiple 4-2 
selecting 4-2 

keyboard procedure 6-14, 6-15 
starting the emulator 

VT240 14-2 
VT240CM1 14-2 
VT240CM2 14-2 

support 30-3 
temporary 3-13 
types of 34-6 

FILL command 39-13 
Filling a shape 27-5 
Filters 38-3 
Find command 18-9, 19-12 
FIND command 32-50 
Find dialog box 18-9, 19-12 
Find Next command 18-9, 19-12 
Finding text 

in Cardfile 19-12 
in Notepad 18-9 

Fine Grid command 28-10 
Finishing 

applications 

Index IIIII 

keyboard procedure 6-8, 6-9 
MS-DOS programs 3-15 
MS-Paint 26-8 
MS-Windows 3-15 

standard applications 7-5 
Flip Horizontal command 27-7, 28-5 
Flip Vertical command 28-5 
FONT command G-3, 32-53 
Font menu 28-5 

commands 28-5 
Fonts section B-27 
FontSize menu 28-5 

commands 28-5 
Fonts 

adding 
deleting 
device 

8-11 
8-13 

8-12 
raster 8-11 
stroke 8-11 
vector 8-11 

FOR command 32-56 
FORMAT command 32-58 
Format Data Disk command 3-9, 5-8 
Formatting 

diskettes H-1 
text 

in Cardfile 
in Notepad 

the hard disk 
Freehand polygon 

G 

19-4 
18-3 

31-9 
27-2 

Get Info command 3-6, 4-4, 4-13 
Getting help 

for NIT 34-24 
on-line information system 29-4 

GO command 39-15 
Go To command 

in Cardfile 19-7 
dialog box 19-7 

GOTO command 32-61 
GRAFTABL command G-3, 32-62 
GRAPHICS command 32-63 

Index-9 
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H 
Hard disk 

copying files to 31-10 
copying system files 31-9 
formatting 31-9 
initializing 31-6 
partition sizes 31-6 
partitioning 31-6 
preparing 31-1 
repartitioning 31-10 
setting drive type 3 1-2 
setting start-up partition 31-8 
what it is 31-1 

HELP command 34-24 
Help 

Information System 29-4 
HEX command 39-17 
Hierarchical directory structure 30-4 
High command 4-10 
Highlight l-S, 3-3 
Hints for Reversi 23-3 
Home key 7-5 
Hourglass 3-13,5-9 

I 
I/O activities 7-1 
Jcon area 3-3 
Icon command 1-7, 2-14 

keyboard procedure 6-7, 6-9 
Icons 2-14, 3-3 

expanding 7 -6 
names 2-3 
shrinking 

keyboard procedure 6-9 
standard applications 7-3 

IF command 32-66 
Illegal file names 30-S 
Image file 

see Binary file 
Index command 
Index dialog box 
Index line 

34-6 
19-7 
19-3, 19-7 

in Cardfile 19-3 
Industry standard compose 36-4 
Information System 1-4, 1-5 
Initial Directory option C-7 
Initializing hard disk 31-6 
INPUT command 39-1S 
Insertion point 

Index-IO 

in Cardfile 19-5 
in Notepad lS-5 

Installation Aid C-1 
Installation menu S-3, S-6 
Internal commands 

characteristics 29-1 
with MS-Windows 29-3 

International section B-1S 
Invert command 2S-5 

J 
JOIN command 32-68 

K 
KB Desired C-S 
KB Required C-S 
Key diskette 3-1 
KEYB command G-3,32-70 
Keyboard labels 

VT220 emulator 11-2 
VT240 emulator 15-1 

Keyboard procedure 6-1 
canceling commands 6-5 
canceling selected files 6-14 
changing window sizes 6-16 
closing applications 6-9 
commands 6-4 
copying E-1 
creating multiple copies E-1 
dialog box 6-10, 6-11 

closing 6-11 
features 6-1 
finishing applications 6-S 
loading applications 6-6 
menus 6-4 
moving windows 6-17 
multiple windows 6-16 
recelvmg messages 6-1S 
removing menus 6-5 
running applications 6-7, 6-S 
scrolling 6-12, E-1 

standard applications 7-4 
selecting commands 6-4 
selecting files 6-14, 6-15 
shrinking icons 6-9 
size box 6-16 
Size command 6-16 
switching windows 6-16 
transferring information 7-7 



using MS-Paint F-1 
Zoom command 6-17 

Keyboard setting command 8-20, 
8-22 

Keyboards 
country 11-1, 15-1 
VT220 emulator 11-2 
VT240 emulator 15-1 

Keys 
Alt/F11 

VT240 emulator 17-4 
Alt/F12 

VT240 emulator 17-5 
Alt/Prt Sc 7-7,7-9 
AIt/Return 6-17 
AIt/spacebar 6-2, 6-4 
AIt/Tab/Shift 6-2 
AIt/Tab 6-2,6-7,6-9,7-6 
Alt 6-2, 6-3 
Arrow/Shift 6-3 
Arrow 6-2,6-4, 6-6, 6-8, 6-10, 
6-12,6-14,7-4 

backspace A-6 
Compose A-3, A-6 
Ctrl/Arrow 6-2 
Ctrl/Break 6-2,6-11 
Ctrl E-1 
End 7-5 
ESC 6-2,6-5 
function keys 

Ctrl/F10 15-3 
Ctrl/F2 15-3 
Ctrl/F5 11-3, 15-3 
FlO (Exit) 15-3 
F11 (ESC) 11-3, 15-3 
F12 (BS) 11-3, 15-4 
F13 (LF) 11-3, 15-4 
F2 (Print Screen) 11-2, 15-3 
F3 (Set-Up) 11-3, 15-3 
F4 (data/Talk) 11-3 
F4 (Data/Talk) 15-3 
F5 (Break) 11-3, 15-3 
Shift/F2 15-3 
Shift/F5 11-3, 15-3 
VT220 emulator 11-2 
VT240 emulator 15-2 

Home 7-5 
Line feed 34-9 
Page Down (Pg Dn) 7-5 

Page Up (Pg Up) 7-4 
Return/Shift 6-3 

Index 11111 

Return 6-2,6-6,6-8,6-10,6-11 
Shift/Ctrl F-2 
Shift/Next 

VT240 emulator 16-13 
Shift/Prev 

VT240 emulator 16-13 
Shift/Tab 6-10, F-2 

L 

Shift 4-2,6-2, A-3, E-1 
Shitf/Prt Sc 6-18 
spacebar 6-2, 6-9 
Tab 6-3,6-10,8-4, F-2 
VT240 emulator 

arrow keys 16-4 
Next screen 16-4 
Previous screen 16-4 
Select 16-4 

Word Char 5-3, 6-3 

LABEL command 32-72 
LASTDRIVE command 1-9 
LCOUNTRY command G-4,32-74 
Leaving the VT220 emulator 10-4 

Close command 10-4 
Icon command 10-4 

Left mouse button 8-24 
Lines 

drawing 
List command 
Listing 

file names 

F-2 
19-20 

5-5 
remote network connections 33-8 

Load command 3-6, 3-10,6-6 
LOAD command 39-19 
Loading applications 

keyboard procedure 6-6 
Local files 

copying to a remote node 34-8, 
34-19 

providing access 34-1 
Logical devices 33-5 
Long command 3-8 
Low command 4-10 

M 
Make System Disk command 3-9, 5-9 
Making a selection 27-6 

Index-II 
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Mark command 7·7,20·12 
Marking 

information 7·7 
dates in Calendar 20·12 

Match Case command 18·9 
MDRIVE command 32·76 
Medium Grid command 28·10 
Memory Requirements option C·8 
Memory 2·2,7·1,7·10, C-2, C·8, 

C·15 
in Calculator 21·3 

Menu bar 3·3, 24·3 
Menus 

Alarm 20·6 
Card 19·5 
Control 4·10,4.11 
drop·down 1· 7 
Edit 18·5, 18·13, 19·10,28·3 
File 3·5,4·4, 18·10, 18·12, ,18·13, 

18·14, 19·14, 19·16, 19·17,26·8, 
28·1 

Font 28·5 
FontSize 28·5 
Installation 8·3, 8·6 
MS·Paint 28·1 
Options 20·10, 28·9 
Palette 26· 7, 28·8 
Preferences 8·3, 8·20 
Priority 4·10 
Search 18·9, 19·7, 19·12 
selecting 

keyboard procedure 6·4 
Setup 8·3,8·14 
Show 20·9 
Special menu 3·4 
Special 3'9 
Style 28·5 
System menu 3·4 
System 3·4, 7·7, 18·10, 19·14, 

26·8 
View menu 3·4 
View 3·7 

Merge command 19·20 
Merge dialog box 19·20 
Merging files in Cardfile 19· 20 
Messages 40·1 

applications 2·18 
MKOIR command 32·78 
MODE command 32·79 

Index· 12 

Month command 20·8 
Month view 

in Calendar 
MORE command 

20·8 
32·90, 38·3 

Mouse 
actions defined 

click 1·3 
double·click 1·3 
drag 1·3 
point 1·3 

cursor 24·3 
settings command 8·20, 8·24 

MOVE command 39·21 
Move command 1· 7 

keyboard procedure 6· 7, 6·17 
Moving 

cards in Cardfile 19· 7 
text 

in Cardfile 19·10, 19·11 
in Notepad 18·8 

through card files 19·5 
windows 2·6 

MS·DOS commands 3·14 
ANSI 32·6 
APPEND 32·7 
ASSIGN 32·9 
ATTRIB 32·11 
BACKUP 32·13 
BREAK 32·17 
CHOIR 32·18 
CHKDSK 32·19 
CLS 32·21 
COMMAND 32·22 
COPY 32·24 
CTTY 32·31 
DATE 32·32 
DEL 32·34 
OIR 32·35 
OISKCOPY 32·37 
ECHO 32~39 

EDLIN 32·41 
ERASE 32·42 
EXE2BIN 32·43 
EXIT 32·45 
FC 32·46 
FOISK 32·49 
FIND 32·50 
FONT G·3, 32·53 
FOR 32·56 



FORMAT 32-58 
GOTO 32-61 
GRAFfABL G-3, 32-62 
GRAPHICS 32-63 
IF 32-66 
JOIN 32-68 
KEYB G-3, 16-21,32-70 

VT240 emulator 16-10 
LABEL 32-72 
LCOUNTRY G-4,32-74 
MDRIVE 32-76 
MKDIR 32-78 
MODE 32-79 
MORE 32-90 
PATH 32-93 
PAUSE 32-95,37-1 
PERMIT 32-97, 33-17 
PRINT 32-98 
PROMPT 32-102 
RECOVER 32-104 
REM 32-106,37-1 
REN 32-107 
RESTORE 32-108 
RMDIR 32-110 
SELECT G-4, 32-111 
SET 32-115 
SET HOST 9-1 
SHARE 32-117 
SHIFT 32-118 
SORT G-4, 32-120 
SUBST 32-123 
SYS 32-125 
TIME 32-127 
TYPE 32-128 
VER 32-130 
VERIFY 32-131 
VOL 32-132 

MS-DOS Executive window 3-1,3-2, 
18-12, 19-16,20-14 

changing directories 5-2, 5-3 
components 3-2, 3-3 
CONTROL.EXE 8-2 
creating directories 5-4 
cursor 3-3 
deleting directories 5-7 
directories 5-1 
disk drives 5-11 
diskettes 5-8 
displaying disks 5-11 

Index IIIII 
displaying multiple directories 5-6 
drive icons 3-3 
first window 1-2 
highlight 3-3 
icon area 3-3 
icons 3-3 
listing directories 3-3 
menu bar 3-3 
naming disks 5-10 
path name 3-3,5-1 
path 3-3 
preparing disks 5-8 
printing directory listings 5-6 
scroll bars 3-3 
size box 3-3 
System menu box 3-3 
title bar 3-3 
work area 3-3 

MS-DOS operating system 3-16 
WIN.INI 

VT220 emulator 13-2 
MS-DOS programs 3-14 
MS-Paint commands 

Align Center 28-7 
Align Right 28-7 
Align 28-7 
Clear 28-5 
Coarse Grid 28-10 
Copy 27-7, 28-4 
Create 28-1 
Cut 28-4 
Edit Pattern 28-11 
Erase 28-4 
Fine Grid 28-10 
Flip Horizontal 27-7,28-5 
Flip Vertical 28-5 
Invert 28-5 
Medium Grid 28-10 
New 28-2 
No Grid 28-10 
Opaque 28-7 
Open 28-2 
Paste 27-7,28-4 
Patterns 27-4, 27-5 
Print 28-1, 28-2 
Save As 28-2 
Save 28-1,28-2 
special effects 28-5 
Trace Edges 28-5 

Index-13 
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Transparent 28-7 
Undo 28-4 
Zoom In 27-8, 28-10 
Zoom Out 27-9, 28-10 

MS-Paint 24-1,26-1 
MS-Windows commands 

About 1-7,3-4, C-3 
Add New Font 8-6, 8-11 
Add New Printer 8-6, 8-7 
All 3-8 
By Date 3-8 
By Kind 3-8 
By Name 3-8 
By Size 3-8 
Change Directory 3-9, 5-2 
Close 1-7,3-15,4-13,6-9,7-3 

VT220 emulator 10-4 
Communications Port 8-14 
Connections 8-7, 8-14 
Copy 2-17, 3-6, 4-4, 4-5, 4-6, 5-4, 

7-7, 7-8 
VT220 emulator 10-4 

Country settings 8-20, 8-25 
Create Directory 3-9, 5-4 
Cut 2-17 
Delete Font 8-6,8-13 
Delete Printer 8-6, 8-10 
Delete 3-6, 4-4, 4-6, 5-7 
End Session 3-9, 3-15 
Format Data Disk 3-9, 5-8 
Get Info 3-6, 4-4, 4-13 
High 4-10 
Icon 1-7,2-14,6-7,6-9 

VT220 emulator 10-4 
Keyboard settings 8-20, 8-22 
Load 3-6,3-10,6-6 
Long 3-8 
Low 4-10 
Make System Disk 3-9, 5-9 
Mark (-( 

VT220 emulator 10-4 
Mouse settings 8-20, 8-24 
Move 1-7,6-7,6-17 
Network Terminal Services 8-14 
New C-5 
Partial 3-8, 5-5 
Paste 2-17, 7-7, 7-8 

VT220 emulator 10-4 
Pause 4-11 

Index-14 

Print 3-6,4-4,4-7,5-6,8-15 
Printer 8-14,8-15 
Programs 3-8 
Rename 3-6, 4-4, 4-12 
Resume 4-11 
Run 3-6,3-12,3-14, 5-6,6-8,7-6, 
8-2, C-4 

configuration files 13-2 
VT220 emulator 10-2 
VT240 emulator 14-2 

Screen colors 8-20 
selecting 

keyboard procedure 6-4 
Set Volume Name 3-9, 5-10 
Short 3-8 
Size 1-7,2-9,2-12,6-16 
Terminate 4-11 
Zoom 1-7, 2-13, 2-14,6-17 

MS-Windows 3-15 
eXiting 29-5 
finishing 3-15 

standard applications 7-5 
initialization file 18-1 
MS-DOS Executive window 18-1, 

18-12, 19-1, 19-16,20-1,20-14, 
21-1,22-1,23-1 

restarting 3 -16 
returning 7-6 
using external commands with 

29-2 
using internal commands with 

29-3 
MSDOS.EXE 5-6 

N 
NAME command 39-23 
Naming files 30-7 
NET CLEAR command 33-13 
NET CONTINUE command 33-11 
NET DEFINE command 33-13 
NET HELP command 33-4 
NET LIST command 33-14 
NET PAUSE command 33-10 
NET PRINT command 33-9 
NET START LAT command 33-15 
NET TEST command 33-15 
NET TIME command 33-16 
NET USE command 33-6 
NET.EXE 3-14 



Network commands 
NET CLEAR 33·13 
NET CONTINUE 33·11 
NET DEFINE 33·13 
NET HELP 33·4 
NET LIST 33·14 
NET PAUSE 33·10 
NET PRINT 33·9 
NET START LAT 33·15 
NET TEST 33· 15 
NET TIME 33·16 
NET USE 33·6 

Network File Transfer (NFT) utility 
34·1 

Network Terminal Services command 
8·14 

Network Terminal Services 
MSNET.INI 16·13 
VT220 emulator 12·9, 12·10 
VT240 emulator 14·3, 16·10, 

16· 11 
Network 

changing drives 33·9 
connecting 3·15, 33·4 

directory 33·7 
remote printer 33· 7 
resource 33·6 

disconnecting 3· 15 
from remote directory 33· 12 
from remote printer 33· 12 
from resources 33·1 2 

listing remote connections 33·8 
logical devices 33·5 
physical devices 33·5 
printing a file 33·9 
specifying device names 33·5 
temporarily disconnecting 33· 1 0 
what a network is 33·2 

New command C·5, 18·11, 19·15, 
20·13,23·3,28·2 

NFT commands 
APPEND 34· 11 
COpy 34·14 
DELETE 34·20 
DIRECTORY 34·21 
EXIT 34·23 
HELP 34·24 
PRINT 34·25 
SET 34·26 

SHOW 34·27 
SUBMIT 34·28 
TYPE 34·29 
using 34·8 

NFT qualifiers 
/NOCONVERT 34· 7 
for COPY 34· 14 
for DELETE 34·20 
for DIRECTORY 34·21 
for HELP 34·24 
for PRINT 34·25 
for SUBMIT 34·28 

NFT 34·1 
abbreviating 

commands 34·9 
qualifiers 34·9 

exiting from 34·2, 34·23 
getting help 34·24 
starting 34·2 
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using long commands 34·9 
No Grid command 28· 1 0 
Nonstream file system 34· 7 
Notepad commands 

About 18·10 
Clear 18·7 
Copy 18·5, 18·8 
Cut 18·5, 18·8 
Delete 18· 15 
Find Next 18·9 
Find 18·9 
Match Case 18·9 
New 18·11 
Open command 18· 13 
Open 18·12 
Paste 18·5, 18·8 
Print 18·15 
Save As 18·14 
Save 18·15 
Select All 18· 7 
Time/Date 18· 13 
Undo 18·7 

Notepad files 18· 1 0 
deleting 18· 15 
file size 18· 1 0 
opening files 18· 11 
opening 18· 11 
printing 18· 15 
saving changes 18· 15 
saving 18· 14 
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viewing IS-13 
Notepad window IS-II 
Notepad B-3 

canceling edits IS-7 
copying text IS-S 
deieting files IS-15 
deleting text IS-7 
editing IS-5 
finding text IS-9 
formatting text IS-3 
insertion point IS-5 
introducing IS-1 
moving text IS-S 
opening files IS-II 
printing files IS-15 
saving changes IS-15 
saving files IS-14 
scroll bars IS-4 
scrolling IS-4 
selecting text IS-6, IS-7 
starting IS-1 
time log file IS-13 
typing text IS-2 
viewing files IS-13 
window IS-2 

Num Lock 6-12 

o 
Opaque command 2S-7 
Open command IS-12, IS-13, 19-16, 

19-17,20-14, 20-15, 2S-2 
Open dialog box IS-12, IS-13, 

19-16, 19-17,20-14,20-15 
Opening 

files 
in Calendar 
in Cardfile 
in Notepad 

Operating system 

20-13,20-14 
19-15 
IS-II 

commands 32-1 
Options menu 20-10, 2S-9 

commands 2S-9 
Coarse Grid 2S-10 
Edit Pattern 2S-11 
Fine Grid 2S-10 
Medium Grid 2S-10 
No Grid 2S-10 
Zoom In 2S-10 
Zoom Out 2S-10 
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OUTPUT command 39-26 

p 

Page Down (Pg Dn) key 7-5 
Page Up (Pg Up) key 7-4 
Palette menu 26-7, 2S-S 

commands 2S-S 
Palettes 26-7 
Partial command 3-S, 5-5 
Partitioning hard disk 31-6 
Pass command 23-2 
Password 34-3 
Paste command 2-17, 7-7, 7-S, lS-5, 

IS-S, 19-10, 19-11, 19-12, 19-13, 
20-5, 21-4, 27-7, 2S-4 

Pasting 2-16 
PATH command 32-93 
Path name 3-3,5-1,30-5 

changing directories 5-3 
Paths 3-3, 30-5 

used with external commands 30-7 
Patterns command 27-4, 27-5 
Patterns 

adding 27-4 
Pause command 4-11 
PAUSE command 32-95, 37-1 
PERMIT command 32-97, 33-17 
Physical devices 33-5 
Picture command 19-13 
PIF section B-13 
PIF 7-2 

changing C-l 5 
Close Window on exit option 
closing standard applications 
contents C-13 
creating C-4 
customized C-2 
default settings C-13 
defined C-l 

C-12 
7-4 

Directly Modifies Memory option 
7-10 

Directly Modifies option C-9 
editing C-S 
editor C-3 
getting help C-3 
Initial Directory option C-7 
KB Desired C-S 
KB Required C-S 
Memory ReqUirements option C-S 



options C-5 
Program Name option C-6 
Program Parameters option C-6 
Program Switch option 7-6, C-II 
Program Title option C-6 
running applications C-2 
Screen Exchange option C-I2 
standard applications 7 -2 

Pipes 38-3 
Playing Reversi 23-3 
Point 

action defined 1-3 
Polygon F-2 

freehand 27-2 
Pop-up program 7-11 
Ports section B-16 
Preferences menu 8-3 

commands 
Country settings 8-20, 8-25 
Keyboard settings 8-20, 8-22 
Mouse settings 8-20, 8-24 
Screen Colors 8-20 
Screen colors 8-20 

Print command 3-6, 4-4, 4-7, 5-6, 
18-15, 19-19,20-17, 28-1, 28-2 

default printer 8-15 
PRINT command 32-98, 34-25 
Print dialog box 20-17 
Print queue 4-9 
Printer command 
Printer connections 
Printer driver files 
Printers 

8-14,8-15 
8-14 

8-7 

adding 8-6, 8-7, 8-9 
removing 8-10 

Printing 
cards in Cardfile 19-19 
default printer 4-8 
directory listings 5-6 
files 4-7,33-9 

in Calendar 20-17 
in Cardfile 19-19 
in Notepad 18-15 

graphics mode 4-11 
in MS-Paint 26-8 
MS-DOS files 34-25 
print queue 4-9 
screens 6-18 

Priority menu 4-10 
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Program Information Editor window 
C-4 

Program Name option C-6 
Program Parameters option C-6 
Program Switch option C-11 
Program Title option C-6 
Programs command 3-8 
PROMPT command 32-102 
Prompts 

NIT 34-2, 34-9 
operating system symbol 30-2 

Prt Sc key 36-4 
PTRACE command 39-27 

Q 
Question mark 

as a wildcard 
QUIT command 

30-9 
39·29 

R 
Recall Set-Up Parameters 

Actions Set-Up screen 
VT220 emulator 13-3 
VT240 emulator 17-3 

Recalling 
Set-Up files 

VT220 emulator 13-2 
VT240emuiator 17-2 

settings 
VT220 emulator 13-3 
VT240 emulator 17-3 

Receiving characters from a host 
session logging 13-3,13-4,17-4 

RECOVER command 32-104 
Redirecting output 38-2 
REGISTER command 39-30 
REM command 32·106, 37-1 
Remote files 

accessing 34-1 
copying to a local node 34-7 

Remove command 20-18 
Remove dialog box 20-18 
Removing 

days in Calendar 20-18 
menus 

keyboard procedure 6-5 
printers 8-10 

REN command 32-107 
Rename command 3-6,4-4,4-12 
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Renaming files 4-12 
Repartitioning hard disk 31-10 
Reserved words 30-2 
Resources 7 -2 
Restarting MS-Windows 3-16 
Restore command 19-13 
RESTORE command 32-108 
Restoring cards in Cardfile 19-13 
Resume command 4-11 
Return key 6-2,6-6,6-8,6-10,6-11 
Return/Shift key 6-3 
Returning to MS-Windows 7-6 
Reversi commands 

New 23-3 
Pass 23-2 

Reversi window 23-2 
Reversi 

hints 23-3 
introducing 23-1 
playing 23-3 
rules 23-2 
starting new games 23-3 
starting 23-1 

Right mouse button 8-24 
RMDIR command 32-110 
Root directory 30-4 
Rules for Reversi 23-2 
Run command 3-6, 3-12, 3-14, 5-6, 

7-6, 8-2, C-4 
keyboard procedure 6-8 

Running applications 
file name 3-11,3-13 

Running 

S 

applications C-2 
keyboard procedure 6-6,6-7, 
6-8 

Control Panel 8-1 
multiple standard applications 7-5 
standard applications 

large 7-10 
outside windows 7-5 

Save As command 18-14, 19-18, 
20-16,28-2 

Save As dialog box 18-14, 19-18, 
20-16 

Save command 18-15, 19-19, 20-17, 
28-1,28-2 
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Save Set-Up Parameters 
Actions Set-Up screen 

Vf220 emulator 13-3 
VT240 emulator 17-2 

Saving 
changes 

in Calendar 
in Cardfile 
in Notepad 

20-17 
19-19 
18-15 

files 
in Calendar 
in Cardfile 
in Notepad 

20-15 
19-18 
18-14 

Set-Up files 
Vf220 emulator 
Vf240 emulator 

settings 

13-2 
17-2 

VT220 emulator 13-2 
Vf240 emulator 17-2, 17-3 

Scratch pad 20-4, 20-12 
Screen colors command 8-20 
Screen Exchange option C-12 
Screens 

printing 6-18 
Scroll arrow 1-6 
Scroll bars 1-5,3-3, 18-4 
Scroll box 1-6, 19-6 
Scrolling E-1, 27-10 

defined 1-5 
in Calendar 20-3,20-7 
in Cardfile 19-6 
in Notepad 18-4 
keyboard procedure 6.12 
mouse procedure 1-5 
standard applications 7-4 

keyboard procedure 7-4 
Vf220 emulator window 10-3 
Vf220 keys 

Ctrl/Find 10-3 
Clrl/Nexi 10-3 
CtrljPrev 10-3 
Ctrl/Select 10-3 

SEARCH command 39-33 
Search For text box 18-9 
Search menu 18-9, 19-7, 19-12 
Select All command 18-7 
SELECT command G-4, 32-111 
Selecting 



command buttons 
keyboard procedure 

commands 
keyboard procedure 

default printer 8-15 
files 4-2 

Keyboard procedure 
keyboard procedure 

information for transfer 
menus 

keyboard procedure 
multiple files 4-2 
text 

20-4 
19-9 

6-11 

6-4 

6-14 
6-15 
7-7 

6-4 

in Calendar 
in Cardfile 
in Notepad 18-6, 18-7 

times 
in Calendar 20-3 

Selection Net 27-6 
Selection Rectangle 27-6, 28-5 
Selection 

copying E-l 
editing 27-6 
making 27-6 

Serial communications 
integral modem 

VT220 emulator 12-10 
Integral Modem 

VT240 emulator 16-11 
Modem Control 

VT220 emulator 12-10 
VT240 emulator 16-11 

VT220 emulator 12-9, 12-10 
VT240 emulator 16-10, 16-11 

Server 
what it is 33-3 

SET command 32-115, 34-26 
Set Volume Name command 3-9, 5-10 
Set-Up screens 

current selection settings 
VT220 emulator 12-2 

menu bar 
VT220 emulator 12-2 

status section 
VT220 emulator 12-2 

title bar 
VT220 emulator 12-2 

VT220 emulator 
Actions 12-6, 16-7 
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Communications 12-9, 16-10 
Display 12-12, 16-14 
General 12-14, 16-19 
Keyboard 12-17, 16-22 
Printer 12-20, 16-26 
Tabs 12-22, 16-28 
Telephone 12-25, 16-31 

Set-Up selections 
Disconnect Delay 

VT240 emulator 16-13 
Answerback Concealed 

VT220 emulator 12-20 
Answerback String 

VT220 emulator 12-20 
VT240 emulator 16-25 

Answerback 
VT240 emulator 16-25 

Auto Answerback 
VT220 emulator 12-20 
VT240 emulator 16-25 

Auto Repeat 
VT240 emulator 16-26 

Auto Wrap 
VT220 emulator 12-14 
VT240 emulator 16-16 

Background 
VT220 emulator 12-14 
VT240 emulator 16-16 

Blink 
VT220 emulator 12-14 

Break 
VT220 emulator 12-19 
VT240 emulator 16-24 

Caps Lock 
VT240 emulator 16-26 

Clear All Tabs 
VT220 emulator 12-23 
VT240 emulator 16-29 

Clear Communications 
VT220 emulator 12-8 
VT240 emulator 16-9 

Clear Display 
VT220 emulator 12-8 
VT240 emulator 16-9 

Columns 
VT220 emulator 
VT240 emulator 

Cursor Keys 
VT220 emulator 

12-13 
16-16 

12-19 
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VT240 emulator 16-24 VT220 emulator 12-15 
Cursor Style VT240 emulator 16-21 

VT220 emulator 12-14 Port/Network 
VT240 emulator 16-16 VT220 emulator 12-11 

Data Bits and Parity Print Extent 
vT220 emulator 12-12 VT220 emulator 12-22 
VT240 emulator 16-13 VT240 emulator 16-28 

Disconnect Delay Print File Name 
VT220 emulator 12-12 VT240 emulator 16-28 

Exit VT240 Print Mode 
VT240 emulator 16-9 VT220 emulator 12-22 

Font Size VT240 emulator 16-28 
VT220 emulator 12-14 Print Size 

Keyclick VT220 emulator 12-22 
VT240 emulator 16-26 Print Terminator 

Keypad Mode VT240 emulator 16-28 
VT220 emulator 12-19 Printer Type 
VT240 emulator 16-24 VT240 emulator 16-28 

Line mode Recall Set-Up Parameters 
VT220 emulator 12-15 VT220 emulator 12-8 

Line Mode VT240 emulator 16-9 
VT240 emulator 16-21 Receive· File 

Local Echo VT220 emulator 12-9 
VT220 emulator 12-15 Reset Terminal 
VT240 emulator 16-21 VT220 emulator 12-8 

MO-M3 degrees of gray VT240 emulator 16-9 
VT240 emulator 16-16 Save Set-Up Parameters 

Manually Set Tabs VT220 emulator 12-8 
VT220 emulator 12-23 VT240 emulator 16-9 
VT240 emulator 16-29 Send File 

Margin Bell VT220 emulator 12-9 
VT220 emulator 12-19 Set 8 Column Tabs 
VT240 emulator 16-24 VT220 emulator 12-23 

Modem Answer VT240 emulator 16-29 
VT220 emulator 13-1 Set Default Set-Up Parameters 
VT240 emulator 17-1 VT220 emulator 12-8 

Monochrome VT240 emulator 16-9 
VT240 emulator 16-16 Set Tab Intervals 

Multinational Character Set VT240 emulator 16-29 
VT220 emulator 12-17 Set Tab Interval 
VT240 emulator 16-21 VT220 emulator 12-23 

Multinational Mode Shift Lock 
VT220 emulator 12-15 VT240 emulator 16-26 
VT240 emulator 16-22 Show Status 

Network Communications Port VT240 emulator 16-9 
VT240 emulator 16-12 Speed 

Network Terminal Services VT220 emulator 12-12 
VT220 emulator 12-12 VT240 emulator 16-13 

New Line Stop Bits 
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Vf220 emulator 
Vf240 emulator 

Telephone Numbers 
VT220 emulator 

Terminal Emulation 
Vf220 emulator 
VT240 emulator 

TerminalID 

12-12 
16-13 
17-1 

13-1 

12-17 
16-22 

Vf220 emulator 12-17 
Text & Graphics Video Mode 

VT240 emulator 16-16 
Text Cursor 

VT220 emulator 12-14 
VT240 emulator 16-16 

To MS-DOS 
Vf240 emulator 16-9 

Transmit = Receive 
VT240 emulator 16-13 

User Defined Keys 
VT220 emulator 12-17 
Vf240 emulator 16-22 

User Features 
Vf220 emulator 12-17 
VT240 emulator 16-22 

Video Mode 
Vf240 emulator 16-16 

Warning Bell 
Vf220 emulator 12-19 
Vf240 emulator 16-24 

XOFF Point 
Vf220 emulator 12-12 
Vf240 emulator 16-13 

Setting 
Clock 22-2 
hard disk drive type 31-2 
hard disk start-up partition 31-8 
tabs manually 

VT220 emulator 12-23 
Vf240 emulator 16-29 

Setup menu 8-3 
commands 

Communications Pon 8-14 
Connections 8-14 
Network Terminal Services 8-14 
Printer 8-14, 8-15 

Shapes 27-2 
drawing F-2 
filling 27-5 
functions 25-3 

selecting F-2 
summary 25-3 

SHARE command 32-117 
SHELL command 1-10 
SHIFT command 32-118 
Shift key 4-2,6-2, A-3, E-1 
Shift/Ctrl keys F-2 
Shift/Tab 6-10, F-2 
Short command 3-8 
SHOW command 34-27 
Show menu 20-9 
Shrinking 

description 1-14 
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Size box 2-11,2-12,2-14,3-3 
keyboard procedure 6-16 

Size command 1-7, 2-9, 2-12 
keyboard procedure 6-16 

SORT command G-4, 32-120, 38-3 
Source drive 30-3 
Spacebar 6-2, 6-9 
Special applications 7 -10 
Special effects 28-5 

commands 28-5 
editing 27-7 

Special menu 3-4, 3-9 
Change Directory 5-2 
commands 3-9 

Special Time command 20-11 
Special Time dialog box 20-11 
Special times 

in Calendar 20-11 
Specifying Vf220 configuration files on 
startup 13-2 

Spooler window 4-10 
Spooler 4-8, 4-9 

Control menu 4-10, 4-11 
Priority menu 4-10 

Starting the emulator 
login information 

Vf220 emulator 10-2 
VT240 emulator 14-3 

Vf220 emulator 10-2 
Run command 10-2 

VT220 icon 10-2 
Vf240 emulator 14-2 

command format 14-3 
from the MS-DOS operating system 

14-3 
Run command 14-2 
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Starting 
Calculator 21-1 
Calendar 20-1 
Cardfile 19-1 
Clock 22-1 
MS-Paint 26-1 
new games in Reversi 
Notepad 18-1 
Reversi 23-1 
standard applications 

outside windows 
Status section 

autotyping 
VT220 emulator 

character set 
VT240 emulator 

communications 
VT220 emulator 
VT240 emulator 

23-3 

7-6 

13-4 

16-10 

12-4 
16-10 

Insert/Replace modes 
VT240 emulator 16-10 

integral modem 
VT220 emulator 12-4 
VT240 emulator 16-9 

keyboard 
VT240 emulator 16-10 

KEYB 
VT240 emulator 16-10 

printer 
VT220 emulator 12-4 

printing 
VT240 emulator 16-9 

receiving or sending files 
VT220 emulator 12-4 
VT240 emulator 16-9 

telephone modes 
VT220 emulator 12-4 
VT240 emulator 16-9 

VT220 emulator 12-4 
\11'240 emulator 

Show Status 16-9 
Stream file system 34-6 
Style menu 28-5 

commands 28-5 
Align Center 28-7 
Align Right 28-7 
Align 28-7 
Opaque 28-7 
Transparent 28-7 
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Subdirectory 5-1 
SUBMIT command 34-28 
SUBST command 32-123 
Support files 30-3 
Switching 

windows 2-6 
keyboard procedure 6-16 

SYS command 32-125 
System diskette 5-9 
System files 

copying 31-9 
System menu box 3-3, 3-4 

double-clicking 3-15 
System menu 1-14, 3-4, 7-7, 18-10, 

19-14, 26-8 

T 

commands 
About 1-7 
Close 1-7, 1-14 
Icon 1-7 
Move 1-7 
Size 1-7 
Zoom 1-7 

Tab key 6-3,6-10,8-4, F-2 
Template 36-1 
Temporarily disconnecting from the 

network 33-10 
Terminate command 4-11 
Text command 19-13 
Text 27-3 

adding 27-3 
files 18-11 
in Notepad 18-2, 18-3 

Tiling 2-2 
TIME command 32-127 
Time log file 18-13 
Time/Date command 18-13 
Title bar 3-3, 24-3 

shrinking ~- D 

Tools and shapes palette 24-3 
Tools 27-2 

Box 27-1,27-4 
Fill 27-4 
functions 25-2 
Scroll 27-10 
selecting F-2 
Selection Net 27-6 
Selection Rectangle 27-6 



summary 25-2 
Text 27-3 

TRACE command 39-35 
Trace Edges command 28-5 
Transferring information 

applications 7-7 
keyboard procedure 7 -7 
windows 2-16 

Transparent command 28-7 
TYPE command 32-128,34-29 
Typing text 

U 

in Cardfile 19-4 
in Notepad 18-2 

UNASSEMBLE command 39-37 
Understanding Set-Up screens 

VT220 emulator 12-2 
VT240 emulator 16-1 

Undo command 18-7, 19-10, 28-4 
Unmark command 20-13 
Unmarking dates in Calendar 20-13 
Username 34-3 
Using external commands 

with MS-Windows 29-2 
Using internal commands 

with MS-Windows 29-3 
Using MS-DOS Executive window 3-2 
Using Set-Up 

VT220 emulator 12-1 
table information 12-5 
with a mouse 12-5 

VT240 emulator 16-1 
table information 16-6 
with a keyboard 16-4 

Using Setup menu 8-14 
Using special features 

VT220 emulator 13-1 
VT240 emulator 17-1 

Using the emulator 
VT220 emulator 10-1 

keyboard 11-1 
multiple sessions 10-2 

VT240 emulator 14-1 
Using the keyboard 

with the VT220 emulator D-l 
Alt/down arrow D-l 
Alt/left arrow D-l 
Altjright arrow D-l 

Alt/spacebar D-l 
Alt/up arrow D-l 
F3 (Set-Up) E-l 
Next D-l 
Prev E-l 
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right and left arrow E-l 
up and down arrow E-l 

Using the VT220 emulator 
multiple sessions 10-2 

Using VT220 System menu commands 
10-3 

About command 10-4 
Copy command 10-4 
Mark command 10-4 
Paste command 10-4 
Set-Up command 10-3 

Using VT240 video modes 16-17 
Fast Text Only 16-17 
Text & Graphics mode 16-17 

V 
VER command 32·130 
VERIFY command 32-131 
View menu 3-4, 3-7, 3-8 

commands 3-8 
Viewing 

appointments in Calendar 20-7 
dates in Calendar 20-8, 20-9 
files 

in Calendar 20-15 
in Cardfile 19-17, 19-20 
in Notepad 18-13 

times in Calendar 20-7 
VOL command 32-132 
Volume name 5-10 
VT220 emulator keyboard 11-1, 11-2 
VT240 double height/width 

Fast Text Only 16-18 
VT240 double width lines 

Fast Text Only 16-18 

W 
Wildcards 5-5, 30-2, 30-8 

asterisk 30-9 
question mark 30-9 

WIN.INI 7-11,8-1, B-1 
adding printers 8-8 
changing B-3 
Colors section B-I0 
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DecInfo section B-24 
DecKeybd section B-22 
DecLAT section B·21 
Devices section B·26 
Extensions section B-8 
Fonts section B·27 
International section B·18 
naming printers 8·6 
PIF section B·13 
Ports section B·16 
sections B·2 
Windows section B-4 

Windows section B·4 
Windows 1·1 

active 2·6 
changing sizes 2·9, 6·16 
closing 

standard applications 7-3 
enlargening 2·9 

keyboard procedure 6-16 
filling the screen 2-13 

keyboard procedure 6-17 
making smaller 2-12 

keyboard procedure 6·16 
moving 2-6 

keyboard procedure 6-17 
mulitple 

keyboard procedure 6-16 
multiple 2·2 
receiving messages 

keyboard procedure 6·18 
shrinking 2-14 
switching 1-1, 2-6 

keyboard procedure 6-16 
tiling 2-2 
transferring information 2-16 

Word Char key 5-3, 6-3 
Work area 3·3 
Workstation resources 7-2 
WRITE command 39-39 

Z 
Zoom command 1-7, 2·13, 2-14,6-17 
Zoom In command 27-8, 28-10 
Zoom Out command 27·9, 28·10 
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Appendix A 
Creating 

Alternate Characters 

This appendix describes how to: 

• Use the CtrljAlt and CtrljAltjleft-Shift key sequences with any key that 
has three or four keycap legends 

• Create characters using: 

- Three-key compose sequence 

- Two-key compose sequence 

• Alt numeric pad sequence 

With the keyboard, you can create many alternate characters and accented 
letters that do not exist as standard keys on your keyboard. This appendix 
describes how to create alternate characters and accented letters. 

Using Keys With Three or Four Legends 

Some keys on the main keyboard have three or four keycap legends. Figure 
A-I shows an example of a three legend key. 

""".f.j'''''' = f'_ # i: .4 $ 
2: 1 3 14-............• , ......... . . . 

\ ! ..... .....• . ........ . - .... -
!~ ~=:.J jV·~ ~ 1\ 

i _a_.) 1 .1.. .. _ ~ 

Figure A-I Three Legend Key 

A·I 



IIIII Creating Alternate Characters 

For more information about which country keyboards have three or four leg­
end keys, see Appendix G. 

To generate the desired key legend, use CtrI/Alt or the CtrI/Alt/left-Shift key 
sequence, depending on the country keyboard: 

• Type 1 country keyboards: U.S./United Kingdom (U.K.) 

• Type 2 country keyboards: French, German, Spanish, Italian, Swiss­
French, Swiss-German, and Hebrew 

• Type 3 country keyboards: Danish, Norwegian, Swedish, Finnish, and 
Canadian 

Type 1 Country Keyboards 

On Type 1 keyboards, only the 3 key has three legends. 

On the U.S. keyboard, to display the # sign, press Shift/3. To display the £ 
sign, press the CtrI/Alt/3 key sequence. 

On the U.K. keyboard, to display the £ sign, press Shift/3. To display the # 

sign, press the CtrI/Alt/3 key sequence. 

Type 2 Country Keyboards 

On Type 2 keyboards, one or more keys contain three characters; however, 
the third character is always located in the lower-right corner of the key. 

To display the third character, press CtrI/Alt and the key. 

Type 3 Keyboards 

On Type 3 keyboards, one or more keys contain three legends; some contain 
four. 

Some characters on the multilegend keys are duplicated on different keys. 
When these characters are on the right-hand side of the key, they function as 
the U.S./U.K. keyboard keys. When you run U.S. software, you can use these 
keys to simulate a U.S. keyboard. (All the other keys have their characters in 
the same position as the U.S./U.K. keyboard.) 

To display the character in the lower-right corner, press CtrI/Alt and the key. 
To display the character in the upper-right corner, press the CtrI/AIt/left­
Shift sequece and the key. 

For more information about country keyboard layouts, see Appendix G. 
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Using Compose Sequences 

You can create and display alternate characters and accented letters that do 
not exist as standard keys on your keyboard by using a compose sequence. 
The compose sequence consists of typing either a three-key sequence or a 
two-key sequence. 

NOTE 
You can only create compose sequences on applications designed 
for MS-Windows. This sequence does not work for standard 
applications that run in a window. 

With the three-key sequence, you use the Compose key, located at the top 
left of your keyboard. With the two-key sequence, you do not use the Com­
pose key. 

In both the three-key and the two-key sequences, to select an uppercase 
character or symbol, press the Shift key before you press the keyboard 
character. 

Table A-2 list all valid compose sequences. Different countries use different 
keyboards. Therefore, the resultant compose characters listed in column 1 
can be created in several ways, according to your keyboard: 

• Use a standard key, if available on the keyboard. 

• Use a two-key compose sequence. 

This is available only if the nons pacing diacritical mark, initiating a 
two-key compose sequence, is available on the keyboard and is defined 
by the keyboard's nationality. 

• Use a three-key compose sequence. 

This is available on all keyboards. 

You cancel a compose sequence by pressing the backspace key. 
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Using the Two-Key Compose Sequence 

The two-key sequence can be used on all keyboards having a nonspacing 
diacritical mark that initiates a two-key compose sequence. Nonspacing dia­
critical marks are available on all keyboards except the U.S.jU.K. keyboards. 

The diacritical marks that initiate a two-key compose sequence vary among 
the keyboards according to the nationality of the keyboard. Only the diacriti­
cal marks associated with the nationality of the keyboard initiate the two-key 
compose sequence. For example, pressing the umlaut key on a German key­
board initiates a two-key compose sequence, while pressing the tilde key 
does not, even though it is on the keyboard. This is because the umlaut is a 
German language diacritical while the tilde is not. To see which diacritical 
marks are available according to the keyboard's nationality, see Appendix G. 

Table A-2 lists all valid two-key compose sequences. 

To use the two-key compose sequence: 

1. Locate in Column 1 of Table A-2 the character you want to create and 
verify from Column 2 that the character can be created using the two­
key sequence. 

2. Press the nonspacing key with the diacritical mark shown in Column 2. 

This is not displayed on the screen. 

3. Type the second character shown in Column 2. 

The composed character is displayed. 

The characters in a two-key compose sequence must by typed in the order 
shown in Table A-2. 

If you type an invalid compose sequence, the keyboard bell rings once, and 
the compose sequence is terminated. Check the table carefully and repeat 
the steps to compose a character. 
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Using the Three-Key Compose Sequence 

The three-key sequence can be used on all keyboards. Table A-2 lists all valid 
three-key compose sequences. 

To use a three-key sequence: 

1. Locate the character you want to create in Column 1 of Table A-2. 

2. Press the Compose key. 

3. Type the two characters from Column 3 that correspond to the charac­
ter you want to create. 

The characters you type after pressing the Compose key are not dis­
played. After you type the two characters, the composed character is 
displayed at the cursor. 

Output characters are case dependent. 

The order in which you enter required characters does not matter unless 
otherwise indicated in Table A-2. 

If you type an invalid compose sequence, the keyboard bell rings once, and 
the compose sequence is terminated. If this happens, check the table care­
fully and repeat the steps to compose a character. 

If you use a diacritical mark in a three-key sequence, it is treated as its 
equivalent character. Table A-I describes the mark and its equivalent 
character. 

Table A-I Diacritical Mark in a Three-Key Sequence 

Diacritical Mark 

Dieresis (umlaut mark) 

Acute accent 

Grave accent 

Circumflex accent 

Tilde mark 

Ring mark 

Equivalent Character 

Double Quote II 

Apostrophe' 

Single quote' 

Circumflex character ~ 

Tilde character -

Asterisk • or degree sign 0 
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Finishing or Restarting a Compose Sequence 

If you enter the compose mode by mistake, or to end the compose sequence, 
press the backspace key and exit from the compose mode. 

If you press the Compose key during a compose sequence, a new three-key 
sequence is started from that point. The previous sequence is ended. 

NOTE 
Table A-2 contains all possible compose sequences for applications 
that run under MS-Windows. However, no single application can 
create all of these compose characters. There are two different sets 
of compose characters. An application can use only one set of 
compose characters at a time. 

Applications use either the International Standards Organization 
(ISO) Latin-1 character set or the DEC Multinational Character Set 
(DEC MCS). Both sets contain all of the compose sequences except 
those listed with a single asterisk C) or a double asterisk (") in 
Column 1. A single asterisk C) identifies the compose characters 
in the ISO Latin-1 character set only, while a double asterisk C') 
identifies the compose characters in the DEC MCS set only. 

For standard applications that run outside a window, use the 
MS-DOS operating system to use compose sequences. 

Table A-2 Valid Compose Sequences 

Character 

# (number sign) 

@ (commercial at) 

[ (opening bracket) 

\ (backslash) 

1 (closing bracket) 

{ (opening brace) 

I (vertical line) 

: (broken vertical bar) , 

l (closing brace) 
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Two-Key 
Sequence Three-Key Sequence 

++ 

aa 

« 
1< or II 

» 
-( 

!' 
: I or I/ 

)-



Table A-2 Valid Compose Sequences (cont.) 

Character 

« (angle quotes left) 

» (angle quote right) 

NBSP (No Break Space) • 

j (inverted !) 

i, (inverted ?) 

o ( degree sign) 

© (copyright sign) 

® (reg. trademark) • 

¢ (cent sign) 

£ (pound sign) 

" (general currency) 

Y (yen sign) 

- (soft hyphen) • 

.. (macron sign) • 

!1 (micro sign) 

, (logical NOT sign) 

± (plus/minus sign) 

X (multiply sign) 

-7- (divide sign) 

1 (superscript 1) 

2 (superscript 2) 

3 (su perscri pt 3) 

~ (paragraph sign) 

§ (section sign) 

~ (feminine ordinal) 

Q (masculine ordinal) 

• ( middle dot) 

Two-Key 
Sequence 
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Three-Key Sequence 

« 

» 

(sp)(sp) (Two spaces) 

!! 

?? 

co 

ro 

c/ or cI 

1- or 1= 

xo 

y- or y= 

/u 

-, (order sensitive) 

+-

xx 

-: (order sensitive) 

1/ 

21' 

!p 

so or s! 
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Table A-2 Valid Compose Sequences (cont.) 

Character 

1/4 (fraction one-quarter) 

1/2 (fraction one-half) 

3/4 (fraction three-quarters) • 

13 (German sharp s) 

i) (cap Icelandic Eth) • 

" (sm Icelandic Eth) • 

(j) (0 slash) 

~ (0 slash) 

p (cap Icelandic Thorn) • 

p (sm Icelandic Thorn) • 

- (tilde character) 

. (grave accent) 

, (apostrophe) 

, (acute accent) • 

A (circumflex character) 

II (double quote) 

.. (dieresis) • 

, ( cedilla) • 

A (A grave) 

it (a grave) 

A (A acute) 

a (a acute) 

a (a circumflex) 

A (A tilde) 

a (a tilde) 
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Two-Key 
Sequence 

- (sp) 

(sp) 

, (sp) 

1\ (sp) 

II (sp) 

'A 

'a 

'A 

'a 

Three-Key Sequence 

14 (order sensitive) 

12 (order sensitive) 

34 (order sensitive) 

ss 

-D 

-d 

0/ 

0/ 

TH (order sensitive) 

th (order sensitive) 

- (sp) 

. (sp) 

, (sp) 

A (sp) 

dieresis (sp) 

1111 

A' 

a' 

A' 

a' 

a-



Table A-2 Valid Compose Sequences (cont.) 

Character 

A (A umlaut) 

a (a umlaut) 

A (A ring) 

a (a ring) 

JE (AE ligature) 

<e (ae ligature) 

<:: (C cedilla) 

~ ( c cedilla) 

E (E grave) 

e (e grave) 

E (E acute) 

e (e acute) 

E (E circumflex) 

e (e circumflex) 

E (E umlaut) 

e (e umlaut) 

i (I grave) 

i (i grave) 

i (I acute) 

i (i acute) 

I (I circumflex) 

i (i circumflex) 

i' (I umlaut) 

i" (i umlaut) 

N (N tilde) 

Ii (n tilde) 

Two-Key 
Sequence 

"A 

"a 

'A or 'A 

,C 

,c 

'E 

'e 

'E 

'e 

/\e 

liE 

lie 

'I 

'i 

'I 

'i 

/\1 

"I 
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Three-Key Sequence 

A" 

a" 

A' or N (degree sign) 

a' or a' (degree sign) 

AE (order sensitive) 

ae (order sensitive) 

C, 

c, 

E' 

e' 

E' 

e' 

E/\ 

e/\ 

E" 

e" 

I' 

i' 

I' 

i' 

1/\ 

I" 

i" 
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Table A-2 Valid Compose Sequences (cont.) 

Character 

b (0 grave) 

o (0 grave) 

6 (0 acute) 

6 (0 acute) 

6 (0 circumflex) 

o (0 circumflex) 

6 (0 tilde) 

6 (0 tilde) 

o (0 umlaut) 

6 (0 umlaut) 

(E (OE ligature) 

re (oe ligature) .. 

U (U grave) 

u (u grave) 

U (U acute) 

u (u acute) 

U (U circumflex) 

u (u circumflex) 

U (U umlaut) 

ii (u umlaut) 

Y (Yacute) • 

y (yacute) . 

Y (Y umlaut) .. 

y (y umlaut) 

A-IO 

Two-Key 
Sequence 

'0 

'0 

'0 

'0 

-0 

"0 

"0 

'U 

'u 

'U 

'u 

"U 

"u 

'Y 

'y 

"Y 

"y 

Three-Key Sequence 

0' 

0' 

0' 

0' 

0-

0" 

0" 

OE 
(order sensitive) 

oe 
(order sensitive) 

U' 

u' 

U' 

u' 

U" 

u" 

Y' 

y' 

Y" 

y" 
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Alt Numeric Pad Sequence 

To use the Alt numeric pad seqeunce: 

1. Press and hold down the Alt key. 

2. Press three numeric keypad number keys. 

3. Release the Alt key. 

The numbers act as an index for the application's currently selected charac­
ter set. 

For example, to compose an uppercase C cedilla and the currently selected 
font is STn (IBM): 

1. Press the Alt key. 

2. Press 1, 2, and 8 on the numeric keypad. 

3. Release the Alt key. 

An uppercase C cedilla is composed. 

If the currently selected font is ISO Latin-I, the output for ALT 1,2,8 is not a 
displayable character, and the output is displayed as a solid block. To pro­
duce an uppercase C cedilla when the ISO font is selected, you must type 
1,9,9 while holding down the Alt key. 

The output for this compose sequence is not remapped from STn to ANSI. 
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AppendixB 
Information About 

the WIN.INI File 

This chapter describes the WIN.INI file, which contains some applications 
and settings for many MS-Windows features and applications. MS-Windows 
checks the WIN .INI file and uses these settings each time you start 
MS-Windows or an MS-Windows application. 

NOTE 
You rarely need to change the WIN.INI file. The Configuration 
Aide creates the WIN.INI file on the key diskette. This appendix 
provides the instructions primarily for special system 
customization. The settings in your WIN.INI can vary from those 
shown here. 

You should print a copy of the WIN.INI file before you change it, using the 
Print command from the MS-DOS Executive window. 

MS-Windows searches for the WIN.INI file in the directory from which you 
start MS-Windows. If MS-Windows does not find the WIN.INI file in that 
directory, MS-Windows searches the directories given in the path. 

You can place comments in the WIN.INI file by making the first nonspace 
character a semicolon (;). Comments cannot contain equal signs. 

B-1 



11111 Information About the WIN.lNI File 

Table B-1 describes the sections of the WIN.lNI file that affect MS-Windows 
settings. 

Table B-1 Sections of the WIN_INI File 

Section Setting 

Windows Controls the loading of the spooler. 
Sets double-click speed. 
Sets cursor blink rate. 
Specifies the file extensions listed in the MS-DOS Executive 
window with the Programs command. 
Defines the name for the null port. 
Starts applications as icons. 
Starts applications in windows. 
Defines default printer device. 
Swaps the action of the mouse buttons. 

Extensions Starts an application when you select a file with the specified 
file extension. 

Colors Specifies the shades of gray in the MS-Window's display screen. 

PIF (Program 
Information File) 

Ports 

International 

DecLAT 

DecKeybd 

DecInfo 

Devices 

Fonts 

B-2 

Defines swap disk and swap size. 
Specifies program information entries for applications used 
with MS-Windows. 

Defines the communication ports you can use. 

Defines MS-Windows for operation in foreign countries. 

Redirects the communications ports to a network terminal ser­
vice. 

Sets the keyboard operation settings. 

Defines the location of the on-line Information System. 

Defines the output devices recognized by MS-Windows. 

Defines the display fonts MS-Windows can use. 
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Changing the WIN .INI File 

Before you change the WIN.INI file, you should be familiar with MS-Windows 
and MS-Windows applications such as Notepad. 

To change the WIN.INI settings, use: 

• The MS-Windows Control Panel 

This is the preferred method for making changes, because MS-Windows 
edits the file for you. Any changes made with the Control Panel take 
effect immediately. 

• The Notepad application to edit the WIN.INI file 

Any changes made with an editor do not take effect until MS-Windows is 
restarted. 

NOTE 
You can use any text editor that produces an ASCII file to edit the 
WIN.INI file. Do not use any editors that include special 
formatting characters in addition to the standard ASCII formatting 
commands. 

Edits made with a text editor do not take effect until MS-Windows 
is restarted. 

The following sections describe the sections of the WIN.INI file. 
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Windows Section 

Purpose 

The Windows section contains settings that take effect when MS-Windows is 
started. 

NOTE 
In the Windows section, you change some settings with the 
Control Panel and some with an editor. To change the double-click 
speed, cursor blink rate, default device, and swap mouse button 
settings, use the Control Panel. To change the programs, load, run, 
spooler, and null port settings, use Notepad. 

Format 

[windows] 
spooler=setting 
DoubleClickSpeed=speed 
CursorBlinkRate=speed 
programs=list 
NullPort=port 
load=list 
run-list 
device=name,driver,port 
SwapMouseButtons=setting 

Where: 

spooler=setting 

Determines whether the spooler is used when printing. The setting 
can be: 

Yes The spooler is used when printing. 

No The spooler is not used when printing. 

DoubleClickSpeed=speed 
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Sets the speed in milliseconds for the double-click operation of the 
mouse. Speed can be 0 to 65535 ms. 
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CursorBlinkRate=speed 

Sets the speed in milliseconds for the cursor blinking action. Speed can 
be 0 to 65535 ms. 

programs=list 

Specifies the files displayed in the MS-DOS Executive window when you 
select the Programs command from the View menu. The list contains 
the file extensions without the period. Separate the file extensions with 
spaces. 

N ullPort=port 

Defines the name for the null port to a specified port. The Control 
Panel, Spooler, and other applications use this port when an output 
device is installed, but is not connected to any port. 

load=list 

Starts the specified applications as icons when you start MS-Windows. 
The list contains the application file names as they are displayed in the 
MS-DOS Executive window without the file extension. (For example, 
Calculator is CALC, because CALC.EXE is the application file name.) 
Include a space between the file names. MS-Windows first searches the 
current drive, the directory, then the path. Otherwise, specify a path 
name. 

To start the MS-DOS Executive window as an icon when you first start 
MS-Windows, you must specify another application to start in a window. 
Use run= to start an application in a window and to start the 
MS-Executive window as an icon. 

You can also start an application as an icon and open a file for that 
application by adding the file name and the file extension to the load 
setting. 

To use this option, you must define the application in the Extensions 
section of the WIN.INI file. 

For example, DOTHIS.TXT starts Notepad because .TXT is in the Exten­
sions section, starting the Notepad application. 
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run=list 

Starts the specified applications in windows when you start 
MS-Windows. You list the file names exactly as they are displayed in the 
MS-DOS Executive window without the file extension. 

When you specify an application to start in a window when you start 
MS-Windows, the MS-Executive window automatically starts as an icon. 

Include a space between the file names. MS-Windows first searches the 
current drive, the directory, then the path. Otherwise, specify a path 
name. 

You should not specify a file name either for a special application or 
for an application that uses a large amount of memory; otherwise, you 
will enter an endless loop when you exit from the application. 

You can arrange windows by using spaces to designate windows within 
the same column, and commas to designate a new column. 

You can start an application and open a data or text file in a window 
when you start MS-Windows by adding the file name and the file exten­
sion in the run setting. To use this option, you must define the applica­
tion in the Extensions section of the WIN.INI file. 

device=name,driver,port 

Defines the default printer ( or plotter): 

name 

driver 

port 

Is the name of the default device. You must also specify 
this default device in the Devices section. 

Is the file containing the device's printer file name with­
out the file extension. 

Is the port to which the device is connected. You must 
also specify this port in the Ports section. 

SwapMouseButtons=setting 
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Swaps the functions performed by the left and right mouse buttons. 
Setting can be: 

No The left mouse button controls the mouse functions. This is 
the default. 

Yes The right mouse button controls the mouse functions. 
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Windows Section Example 

The following Windows section: 

• Enables the spooler when printing. 

• Sets the mouse double-click speed to 900 ms. 

• Sets the cursor blink rate to 550 ms. 

• Specifies that files with the .COM, .EXE, and .BAT file extensions are 
displayed in the MS-DOS Executive window when you use the Programs 
command. 

• Specifies None as the null port. 

• Using no file specifications, starts Notepad and Calculator as icons, and 
starts Notepad with the text file ONGOING.TXT. 

• Statts Clock in the first window of the first column, Calculator in the 
second window of the first column, Notepad in the first window of the 
second column, and Notepad with the file specification 
K\MEMOS\ONGOING.TXT in the second window of the second 
column . 

• Sets the default printer to a DIGITAL LA75, which is connected to the 
LPTl: port. 

• Does not switch the left and right mouse buttons. 

Example 

[window51 
5pooler=ye5 
DoubleClickSpeed=900 
Cur50rBlinkRate=550 
program=com exe bat 
NullPort=None 
load=notepad calc ongoing. txt 
run=clock calc,notepad K:\memo5\ongoing.txt 
device=LA75DEC,LA75,LPT1: 
SwapMou5eButton5=No 
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Extensions Section 

Purpose 

In the Extensions section, you can specify file extensions that let you start an 
. applicaHon and open a me in a single operation. When yQU select a file with 

the specified extension, MS-Windows starts the application and opens the file 
in one step. 

NOTE 
To change the Extensions section, use the Notepad application. 

Format 

[exten5ion51 

exten5ion=application[parameterl 

Where: 

extension 

application 

parameter 

B-B 

Is the file extension that starts the application. 

Is the name of the application that is started. You must in­
clude the application's extension (.EXE). 

Is the name and extension of the file (optional) for the ap­
plication to open. You can use a caret C') to represent any 
file with that extension (for example, J\ • TXT) . Then you can 
select any file with the specified extension, and MS-Windows 
starts the application with that file. 
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Extensions Section Example 

The following Extensions section: 

• Starts the Notepad application when you specify a file containing a .TXT 
file extension. Notepad opens the file. 

• Starts the Notepad application when you specify a file containing an 
.INI file extension. Notepad opens the file. 

• Starts the MS-Paint application when you specify a file containing an 
.MSP file extension. Paint opens the file. 

Example 

[extensions] 

txt=notepad.exe A.txt 

ini=notepad.exe A.ini 

msp=paint.exe A. msp 
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Colors Section 

Purpose 

The Colors section specifies the shading for various components of the 
MS-Windows screen. 

NOTE 
To change the Colors section, use the Control Panel. Set your 
screen to have contrasting text and background colors. Otherwise, 
your screen could look blank. 

Format 

[color5] 

component=redvalue greenvalue bluevalue 

Where: 

component 

Specifies the component of the MS-Windows screen. The component 
can be: 

Window 

WindowText 

Scrollbar 

ActiveTitle 

InactiveTitle 

TitleText 

WindowFrame 

Menu 

MenuText 

Background 

B-JO 

Is the nontextual background of the window 
work area. 

Is the textual display in the window work area. 

Is the scroll bar. 

Is the background of the active title bar. 

Is the background of the inactive title bar. 

Is the application title's text. 

Is the set of lines that form the frame of the win­
dow and the nontextual part of the application's 
title background. 

Is the nontextual background of the menu area. 

Is the textual display in the menu area. 

Is the icon area and screen background. 
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redvalue 

Is a number that specifies the intensity of red used. The number can be 
o to 255. 

greenvalue 

Is a number that specifies the intensity of green used. The number can 
be 0 to 255. 

bluevalue 

Is a number that specifies the intensity of blue used. The number can 
be 0 to 255. 

NOTE 
Because you have a monochrome screen, the redvalue, greenvalue, 
and bluevalue settings affect the gray scale of the MS-Windows 
components. The low end of the gray scale is 0, and the high end 
of the gray scale is 255. Therefore, if all three settings are 0 
(setting=O 0 0), the color is black. If all three settings are 255 
(setting=255 255 255), the color is white. Settings between 0 and 
255 produces varying shades of gray. 

Colors Section Example 

The following Colors section: 

• Sets the nontextual background of the window work area to white. 

• Sets the textual display in the window work area to black. 

• Sets the scroll bar to a shade of gray. 

• Sets the active title bar background color to black . 

• Sets the inactive title bar background color to a shade of gray. 

• Sets the application title to white. 

• Sets the lines that form the frame of the window and the nontextual 
part of the application's title background to black. 

• Sets the nontextual background of the menu area to white. 

• Sets the textual display in the menu area to black. 

• Sets the icon area and screen background to a shade of gray. 

B-11 



IIIII In/ormation About the WIN.INI File 

Example 

[color5] 
Window=255 255 255 
W-i nd-owTex-t-O -0- 0 

Scrollbar=192 192 192 
ActiveTitle=O 0 0 
InactiveTitle=128 128 128 
TitleText=255 255 255 
WindowFrame=O 0 0 
Menu=255 255 255 
MenuText=O 0 0 
Background=128 128 128 
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PIF Section 

Purpose 

The PIF section lists the information that MS-Windows uses to swap programs 
to disk. MS-Windows uses the swap area to swap applications that cannot 
operate in a window. Two settings (SwapDisk and SwapSize) determine 
where MS-Windows swaps an application and the minimum swap space. 

The PIF section creates a program information entry for standard applications 
used in a window. MS-Windows uses the program information entry rather 
than a program information file (PI F). The preferred method is to create a 
PIF. For more information on PIFs, see Appendix C. 

NOTE 
To change the PIF section, use Notepad. 

Format 

[pH 1 

swapdisk=setting 
swapsize=setting 
program=memory 

Where: 

SwapDisk=setting 

Is the disk to which MS-Windows swaps the application. The setting 
can be: 

Swaps to the first fixed disk on the system. This is the 
default. 

dry Swaps to that drive. Drv is any valid drive letter. 

o Disables swapping. 

NOTE 
Do not set a diskette drive as the swap disk. 
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SwapSize=setting 

Is the amount of memory MS-Windows uses to swap an application. The 
setting can be: 

o Is the amount of memory based on the size of the first appli­
cation that MS-Windows swaps. You should start the largest 
application first. This is the default. 

size Is the reserved minimum amount of memory in Kbytes that 
MS-Windows uses to swap applications. When you determine 
the size, consider the application size, the space for screen 
exchange, the space for screen switching, and 2K bytes of 
overhead for saving information about the application's cur­
rent state. 

progra01=01e01ory 

Is the application name for which you want to create a program infor­
mation entry. Memory is the amount of memory in Kbytes required to 
start the application. See the application documentation to find the 
memory requirements for the application. 

When memory is 1, it indicates a special application. 

MS-Windows assumes the following default settings for a program infor­
mation entry: 
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Program Title 

Initial Directory 

Parameters 

Memory Required 

Memory Desired 

Screen Exchange 

Program Switch 

Directly Modifies 

Close Window on Exit 

File name without extension 

None 

None 

Specified to the right of the equal sign 

Same as memory required 

Text 

Text 

None 

No 
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PIP Section Example 

The following PIF section: 

• Sets the swap disk to the default. 

• Sets the swap size to the default. 

• Creates a program information entry for COMMAND.COM with a 32K 
byte memory requirement. 

Example 

[pif] 

5wapdi5k=? 
5wap5ize=O 
command.com=32 
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Ports Section 

Purpose 

The Ports section lists the available communication ports for a workstation 
and-defines-the default modes or settings. The Ports section can include up 
to eight entries. 

NOTE 
To change the Ports section, use the Control Panel. 

Format 

[ports] 
port:=baudrate,parity,wordlength,stopbits,[retry] 
filename.PRH= 

Where: 

port: 

Is the name of the available port. Port can be LPTl:, LPT2:, LPT3:, 
COMl:, or COM2:. 

If the port is COMl: or COM2:, you must specify in order the: 

B·16 

baud rate 

parity 

word length 

stop bits 

retry 

Is the port's baud rate. 

Is the parity setting: 0 (odd), e (even), or 
n (none). 

Is the length of a word, in bits. 

Is the number of stop bits. 

Controls continuous retry on a timeout. This op­
tion is used if the port is used only for a serial 
printer. If you leave this option blank, the cur­
rent setting does not change. 

The retry options are: 

p which enables continuous retry on a tim out 

which disables continous retry on a timeout 



In/ormation About the WIN.lNI File IIIII 

filename.PRN= 

Sends printer output to a file rather than to a printer device. 
MS-Windows prints the information in the file name you specify. You 
must include the .PRN file extension. MS-Windows overwrites the file 
with each print job. 

Ports Section Example 

The following Ports section: 

• Defines the LPTl: communication port. 

• Defines the LPT2: communication port . 

• Defines the COMl: communication port with 9600 baud rate, no parity 
check, 8 bit word length, 1 stop bit, and enabled retry. 

• Defines the COM2: communication port with 2400 baud rate, no parity 
check, 8 bit word length, 1 stop bit, and disabled retry. 

• Defines OUTPUT.PRN as a file for printer output. 

Example 

[ports] 
LPT1: .. 
LPT2:= 
COM1:-9600,n,8,1,p 
COM2:-2400,n,8,1 
OUTPUT.PRH-
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International Section 

Purpose 

The imernationai section teUs MS-Windows how to display dates, times, dol­
lar amounts, and other items in countries other than the United States. 

NOTE 
To change the International section, use the Control Panel. 

Format 

[intlJ 
dialog-5etting 
itemname-5etting 

Where: 

dialog=setting 

Allows changes to the Ir.ternational section through the Control Panel. 
The setting can be: 

Yes Enables the international dialog box. 

No Disables the international dialog box. 

itemname 

Is the item you want to set. The setting can be: 
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iCountry 

iDate 

iCurrency 

Defines the country code. 

Defines the format for the date where: 

o for month-day-year 
1 for day-month-year 
2 for year-month-day 

Defines the format for currency where: 

o for currency symbol prefix, no separation 
1 for currency symbol suffix, no separation 
2 for currency symbol prefix, 1 character 

separation 
3 for currency symbol suffix, 1 character 

separation 



In/ormation About the WIN.INI File IIIII 

iDigits Defines the number of significant decimal digits in 
the currency. 

iTime 

iLzero 

s1159 

s2359 

sCurrency 

sThousand 

sDecimal 

sDate 

sTime 

sList 

'Defines the format for the time where: 

o for 12-hour clock 
1 for 24-hour clock 

Defines the use of leading zeros where: 

o for no leading zeros 
1 for leading zeros 

Defines trailing string from 0:00 to 11:59. 

Defines trailing string from 12: 00 to 23: 5 9. 

Defines currency symbol. 

Defines thousands separator. 

Defines decimal separator. 

Defines date separator. 

Defines time separator. 

Defines list separator. 

International Section Example 

The following International section: 

• Allows changes to the International section through the Control Panel. 

• Defines the country as the U.S. 

• Defines a month-day-year date format. 

• Defines a 0 currency symbol prefix with no separation for the currency 
format. 

• Defines two significant decimal digits in the currency . 

• Defines a 12-hour clock. 

• Defines the use of no leading zeros. 

• Defines an AM to be attached to time from 0:00 to 11:59. 

• Defines a PM to be attached to time from 12:00 to 23:59. 
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• Defines $ as the currency symbol. 

• Defines , as thousand separator. 

• Defines . as decimal separator. 

• D~fines / as date separator. 

• Defines: as time separator. 

• Defines , as list separator. 

Example 

[intl] 
dlelog"'ye5 
iCountry-1 
10ete-O 
lCurrency-O 
iOigi h-2 

i Time-O 
lLzero-O 
5115S"AM 
5235S·PM 
5Currency-S 
5Thou5end-, 
50eclmal-. 
50ate-' 
5Tlme-: 
5L15t-, 
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DecLAT Section 

Purpose 

The DecLAT section redirects the communication ports to a network terminal 
service. 

NOTE 
To change the DecLAT section, use the Control Panel. 

Format 

CDecLATl 

port=5ervice 

Where: 

port Is the communication port that you want to redirect. Port can be 
COM!: or COM2:. Service is the network terminal service to 
which you want to connect. You do not have to specify a partic­
ular network terminal service. 

DecLAT Section Example 

The following DecLAT section: 

• Defines the COMl: communication port. It is not redirected to any net­
work terminal service. 

• Defines the RANGER network terminal service to the COM2: communi­
cation port. 

Example 

[DecLATl 

COM1:= 
COM2:=RANGER 
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DecKeybd Section 

Purpose 

The DecKeybd section specifies the keyboard settings. 

NOTE 
To change the DecKeybd section, use the Control Panel. 

Format 

[DecKeybdl 
keyclick=5etting 
repeat=5etting 
lock=5etting 

Where: 

keydick=setting 

Specifies the volume of sound generated by the keyboard. The setting 
can be from 0 to 3 where 0 is no volume and 3 is maximum volume. 
The default is 2. 

repeat=setting 

Specifies whether the repeat key feature is used. The setting can be: 

o Turns off the repeat key feature. 

1 Turns on the repeat key feature. 

lock=setting 

Specifies the caps lock or shift lock feature of the keyboard. The setting 
can be: 

o Sets the caps lock feature, which capitalizes the letters on the 
keyboard when you press the Lock key. 
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1 Sets the shift lock feature, which acts as if the Shift key is always 
pressed. 
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DecKeybd Section Example 

The following DecKeybd section: 

• Sets the key click to medium volume. 

• Turns on the repeat key feature. 

• Sets the caps lock feature. 

Example 

[DecKeybdl 
keyclick=2 
repeat=1 
lock=O 
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Declnfo Section 

Purpose 

The DecInfo section specifies to MS-Winoows the location of the on-line 
Information System files. You should not need to change any of these 
settings. 

NOTE 
To change the DecInfo section, use the Notepad application. 

Format 

[Declnfol 
DBpath=pathname 
DBname=databa5e 
BMpath=pathname 

Where: 

DBpath 

DBname 

BMpath 
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Specifies the location of the on-line Information System 
database files by the specified path name. 

Specifies the name of the on-line Information System 
database. 

Specifies the location of user specific information regarding 
the on-line Information System by the specified path name. 
For example, the Bookmark file contains information specific 
to you. 
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Declnfo Section Example 

The following DecInfo section: 

• Defines the location of the on-line Information System data files as drive 
H in the DECAPP subdirectory. 

• Defines the name of database as INFOUSER. 

• Defines the location of your specific information regarding the on-line 
Information System as drive I. 

Example 

[Declnf9] 
DBpath=H:\DECAPP 
DBname=II'IFDU5ER 
BMpath=I:\ 
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Devices Section 

Purpose 

The Devices section identifies a workstation's output devices, the printer 
files, and the port connections. 

NOTE 
To change the Devices section, use the Control Panel. 

Format 

[device51 
device=driver,port[,portl 

Where: 

device Is the name of the output device where: 

driver 

port 

Is the file name of the device's printer driver. 

Is the name of the communication port or print file to 
which the device is connected (optional). Port can be 
LPTl, LPT2, LPT3, COMl, or COM2. If a device is not 
currently connected, the port should be the port speci­
fied in the NullPort setting of the Windows section. 

Devices Section Example 

• Defines the DIGITAL LN03 printer as connected to the null port and to 
the LPT3:communication port. 

• Defines the IA75DEC printer as connected to the LPTl :communication 
port. 

• Defines the IBM Graphics printer as the null port. 

Example 

[device51 
Digital LN03=LN03,None,LPT3: 
LA7SDEC=LASO,LPT1: 
IBM Graphic5=IBMGRX,None 
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Fonts Section 

Purpose 

The Fonts section identifies one or more font types that MS-Windows applica­
tions can use for display. 

NOTE 
To change the Fonts section, use the Control Panel. 

Format 

[font5] 

fontname=fontfile 

Where: 

fontname Is the descriptive name of a font. The fontfile is the name of 
the file containing the font resources. Do not use the file 
extension. 

Fonts Section Example 

The following Fonts section: 

• Defines the Courier font. 

• Defines the Helvetica font. 

Example 

[font5] 

Courier 8,10,12 (Set H3)=CDURC 
Helv 8,10,12(SetH3)=HELVC 
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Appendix C 
Program 

Information Files 

This appendix describes how to: 

• Use Program Information Files (PIFs) 

• Use the PIF editor 

• Select PIF options 

• Use default settings 

• Decide what to put in a PIF 

• Change PIFs 

• Give applications more memory 

Using Program Information Files 

A program information file (PIF) is a file that contains information about a 
standard application. It has the file extension .PIF. When you run a standard 
application, MS-Windows looks for a PIF to configure the application. 

PIFs for most popular standard applications are included with your 
MS-Windows software package. During setup, the Installation Aide installs 
PIFs in the PIF subdirectory to establish a PIF library. You probably will not 
enter information into a PIF unless you use a standard application that does 
not have a PIF. 
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NOTE 
If you try to run a standard application that does not have a PIF, 
MS-Windows automatically uses a set of default application 
characteristics. MS-Windows displays a dialog box asking if it 
should "Continue with default settings." You should create a PIF, 
using the correct values from your application documentation. 

If you run an application by selecting the file name of the application (files 
that have the file extension .EXE, .COM, or .BAT), the PIF must have the 
same file name and the file extension .PIF. For example, if you use dBASE II, 
its application file name is DBASE.EXE, and its PIF must be DBASE.PIF. 

You can also run an application by selecting its PIF in the MS-DOS Executive 
window. This automatically loads and runs the application named in the PIF. 
In this case, the PIF does not have to have the same file name as the 
application. 

The preferred method is to run a standard application by selecting its PIF. 
This allows you to have customized PIFs, which are several PIFs containing 
different settings for the same application. Therefore, you can customize an 
application to the needs of different users, each with their own specific 
MS-Windows environment. 

For example, one version, APPLARGE.PIF, may need a large amount of mem­
ory for those that use all of its features, and a second version, APPSMALL.PIF, 
may need less memory for those who use only a few of its features. 

Additionally, each user can have customized values for the Program Parame­
ters or Initial Directory fields in their PIFs. Customized PIFs must be in the 
user's personal directory. 

The PIF must be in your directory or in your path. It should be copied from 
the PIF subdirectory to the directory from which you run the application. 
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In some cases, different applications use the same file name to start up. 
Therefore, some PIFs can have names that differ from their applications. If 
you are not sure which application a PIF works with, run the PIF editor and 
open the PIF to see which application the PIF was designed for, then copy 
the PIF to the appropriate drive and directory, and rename the file. 

Some applications can have more than one .EXE, .COM, or .BAT file on their 
disk. You need a separate PIF for each file. 

Using the PIF Editor 

To create or edit a PIF, use the PIF editor. For example, you can change the 
application settings to increase the amount of memory available to the appli­
cation or to set its initial directory. 

To get on-line help about using the PIF editor: 

1. Select the About command from the System menu. 

A dialog box is displayed that lists topics about PIFs. 

2. Select a topic from the list box. 

3. Select the Help command button. 

Information about the selected topic is displayed in the dialog box. You 
may need to scroll to see all the information. 

By using the command buttons in the dialog box, you can obtain infor­
mation about other PIF topics. 

When you finish using the PIF help feature, select the Cancel command 
button. 
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Creating a PIF 

To create a new PIF: 

I. Use the Run command in the MS-DOS Executive window to start the PIF 
editor application. The file name of the PIF editor is PIFEDIT.EXE. 

The Program Information Editor window is displayed. Screen C-I shows 
the Program Information Editor window. 

aa.J.',i"Mm,"p"Fi"uIM,n, .. 
File 

P,-ogralll Hallle: I 
P,-og,-alll Title: ~I =============~ 

Progralll Parallleters: ~I ==============; 
Initial Directory: L.I _____________ ~ 

Nelllo,-y Requirements: @IJ KB ReQui,-ed @IJ KB Desired 

Di,-ectly Nodifies [2J Screen 0 com 0 Nelllo,-y 

Prog,-am S"litch 
Screen Exchange 

o Keyboard 0 Cm12 
Co Prevent @) Text 
o Hone (~, Text 

Close Hindm!1 on exit 0 

r=, Graphics/Nultiple Text 
() G,-aphics/Text 

Screen C-l Program Information Editor Window 

[. 
" 

2. Type the file name of the application to be associated with the PIF in 
the Program Name text box. Include the file extension (.EXE, .COM, or 
.BAT). 

3. Select the options or values that apply to the application. (For more 
information, see the section "Selecting PIF Options" in this appendix.) 

4. Select the Save command from the File Menu to save the new PIF. 
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To create another PIF, select the New command from the File Menu to reset 
the PIF editor screen. 

Editing PIFs 

To edit an existing PIF: 

1. Use the Run command in the MS-DOS Executive window to start the PIF 
editor. The file name of the PIF editor is PIFEDIT.EXE. 

2. Select the Open command from the File Menu. 

3. Select the PIF you want to change from the list box or type the name of 
the PIF in the text box. 

4. Select the Open button. 

5. Make the desired changes by selecting the PIF options you want. 

6. Select the Save command from the File Menu to save the changes. 

Selecting PIF Options 

PIF options are organized into these categories: 

• Program Name 

• Program Title 

• Program Parameters 

• Initial Directory 

• Memory Requirements 

• Directly Modifies 

• Program Switch 

• Screen Exchange 

• Close Window on exit 
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Program Name 

Every application (program) must have a file name assigned. 

Type the path and file name of the application, including the file extension 
.EXE, . BAT, or .COM. Eor example, DBASE.COM isa file for theappHcation 
DBASE. What you enter is displayed in the MS-DOS Executive window 
directory. 

Program Title 

You can enter a descriptive title for the application to help the user identify 
it on the screen. 

What you enter is displayed in the title bar of the window, if the application 
runs in a window. This same title is also displayed above the icon of the 
application when you highlight the icon in the icon area. 

NOTE 
The PIF editor lets you enter 37 characters in the text box; 
however, only 29 characters are displayed in the title box. 

Program Parameters 

The Program Parameters option lets you pass information to an application 
when you start it. In the Program Parameters text box, you can type either of 
the following: 

• Question mark 

If you type a question mark, MS-Windows displays a dialog box when 
you start the application. The dialog box prompts you for application 
parameters. You can enter up to 126 characters in the dialog box; how­
ever, the application interprets no more than 126 characters. If you 
enter more than 126 characters, MS-Windows does not beep to indicate 
an error. 

e Specific program parameters 

If you type specific parameters, those application parameter values are 
used every time the application is started. You can enter up to 37 char­
acters in the Program Parameters text box. 

You should not redirect input and output or use piping. 

If your application requires no parameters, or if you are uncertain, leave this 
option blank. 
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Initial Directory 

If you have several directories, this option changes to a specific directory 
when the application starts. 

Type the drive and directory you want MS-Windows to change to when you 
start the application. This directory is usually the location of the applica­
tion's data files. 

You can use the Initial Directory field and the Program Name field to make a 
customized PIF for applications shared on a file server. In the Program Name 
field, enter the drive and directory of the application. In the Initial Directory 
field, enter the drive and name of your personal directory. (Complete the 
other PIF fields as needed.) Make sure this customized PIF is in your per­
sonal directory. 

When you select the customized PIF to run an application, MS-Windows cop­
ies the application from its drive and directory and starts it in your personal 
directory where the data files are. The application can then use the data files. 
When you close the application, the updated data files remain in your per­
sonal directory. 

If the data files are in the same directory as the application, leave this option 
blank. In this case, MS-Windows does not change the directory when you 
start the application. 
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Memory Requirements 

Two fields for Memory Requirements allocate memory for your applications: 

• KB Required 

Type the minimum amount of memory required (in kilobytes) by your 
application. 

Memory requirements for your application should be in the application 
documentation. 

If you do not know how much memory is required, use the default 
setting of 52K bytes. 

If MS-Windows cannot provide the specified amount of memory, and if 
no application is running other than the MS-DOS Executive application, 
MS-Windows reduces its space requirements so that the application has 
room to operate. In this case, you cannot switch back to MS-Windows 
with the Alt/Tab keys; you must execute the application's Exit com­
mand, or its equivalent, to return to MS-Windows. 

• KB Desired 
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Type the maximum amount of memory your application can use. Some 
applications run better if you assign more memory. 

The value entered in this field should at least equal the value entered in 
the KB Required field. If the application allocates memory, you should 
increase the value in the KB Desired field, and you may also need to 
increase the value in the KB Required field. 

If you enter zero (0), MS-Windows allocates all available MS-Windows 
memory to the application. 

If you leave this field blank, MS-Windows uses the default setting of 
52K bytes. 

CAUTION 
You should not run the CHKDSK (Check Disk) utility program 
from MS-Windows; otherwise, it can provide invalid messages 
about memory availability. If you select the /F qualifier of 
CHKDSK, you can destroy all data stored on your workstation 
network disk. 
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Directly Modifies 

Some applications use workstation resources such that applications cannot 
share them. Select any options that apply to your application: 

• Screen 

Select this box if the application writes directly to the screen (video 
buffer) or if the application has a .BAT extension and uses redirected 
I/O. Ail standard applications that display graphics write directly to the 
screen. 

Selecting this option gives the application exclusive access to the full 
screen, rather than running it in a window. If you are uncertain, select 
this option. 

• Keyboard 

Select this box if the application accesses the keyboard buffer. This 
buffer saves keystrokes until they can be processed. 

Selecting this option prevents the application from running in a window 
(the application has exclusive access to the full screen) and prevents 
returning to MS-Windows with AIt/Tab. If you are uncertain, do not 
select this option. 

• COM! 

Select this box if your application accesses serial communications port 
! (COM!). If you select this option, MS-Windows reserves COM! for 
the application. When the application is running, MS-Windows cannot 
run any other application using COM! until you stop running the first 
application. Generally, you select this option only if you are running a 
communications application. 

Selecting this option prevents two applications from trying to access the 
same communications port at the same time. Because only one applica­
tion with the COM! option selected can be running at a time, only one 
application attempts to access COM!. 

Selecting this option also prevents the application from being swapped 
to a disk. This type of application must remain in memory at all times. 
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• COM2 

Select this box if your application accesses serial communications port 
2 (COM2). If you select this option, MS-Windows reserves COM2 for 
the application. When the application is running, MS-Windows cannot 
run any other appiicationusing COM2until you stop running the first 
application. Generally, you select this option only if you are running a 
communications application. 

Selecting this option prevents two applications from trying to access the 
same communications port at the same time. Since only one application 
with the COM2 option selected can be running at a time, only one 
application attempts to access COM2. 

Selecting this option also prevents the application from being swapped 
to a disk. This type of application can remain in memory at all times. 

• Memory 

Select this box only if your application loads and remains resident 
(using a Terminate and Stay Resident system call). Many pop-up applica­
tions do this. These applications generally load and remain in memory, 
and are activated while other applications are running. Generally, this 
type of application must be loaded before MS-Windows. In this case, 
you do not need a PIF for the application. If you are uncertain, do not 
select this option. 
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Program Switch 

If your application uses the entire screen, these options determine whether 
you can switch back to MS-Windows with Ait/Tab. If you are uncertain which 
option to select, select Text. 

• Prevent 

Select this option to conserve memory for the application, or if you find 
that the application does not switch to MS-Windows correctly. Selecting 
this option means you can stop running the application only by execut­
ing its Exit command, or the equivalent command, to return to 
MS-Windows. You cannot use the Alt/Tab procedure to return to 

MS-Windows. 

• Text 

Select this option if your application works in text mode only, or if it 
runs in text and graphics modes, and you want to conserve memory. 
When you select this option, MS-Windows reserves 4K bytes to save the 
screen. 

If you select this option, you can switch back to MS-Windows only 
when your application is in text mode. If the application is in graphics 
mode, MS-Windows beeps when you press the Ait/Tab keys, to let you 
know it is not a valid action; you must execute the Exit command of the 
application to return to MS-Windows. 

• Graphics/Multiple Text 

Select this option if your application works in graphics mode. If you 
select this option, MS-Windows allocates extra memory (64K bytes) for 
you to switch back to MS-Windows when the application is in text or 
graphics mode. 

Due to extensive memory requirements, program switching is not sup­
ported for applications using IBM EGA high-resolution color modes. 
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Screen Exchange 

These options let you specify the kind of data exchange between applications 
that require exclusive access to the screen. 

You press Alt/Prt Sc to copy information into the Clipboard. This requires 
MS-Windows to allocate memory to save the screen image in the Clipboard. 
Text screens generally do not require much memory (2K bytes). However, 
graphics screens can require up to 64K bytes of memory. You should select 
options with this in mind. 

If you are uncertain which option to select, select Text. 

• None 

Select this option to prevent screen exchange and conserve memory. 

• Text 

Select this option to allocate memory to copy text screens. If your 
application runs in a window, you can select this option. 

• Graphics/Text 

Select this option to allocate memory to copy text and graphics screens. 

Close Window On Exit 

Select this option to close the standard application window when you exe­
cute the application's Exit command, or its equivalent. 

When you exit from some standard applications, they display information in 
the window for you to look at or copy. Do not select this option, because the 
window closes automatically, and the information is not displayed on the 
screen long enough for you to read it. 
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Using Default Settings 

If you run an application, and MS-Windows cannot find a PIF, MS-Windows 
uses the following settings: 

• Program Title: The application file name is displayed in the title bar. 

• Initial Directory: You stay in your current directory. 

• Memory Required: S2K bytes 

• Memory Desired: All available memory 

• Directly Modifies: Screen 

• Program Switch: Prevent 

• Screen Exchange: Text 

Deciding What to Put in a PIF 

How an application is displayed on the screen depends on: 

• How the application uses workstation resources and hardware 

• How the application is configured 

• The amount of memory reserved for the application 

If MS-Windows cannot run a standard application in a window, it runs the 
application outside a window, and the application uses the entire screen. 

Use the following guidelines to help determine whether your standard appli­
cation can run in a window: 

• Does the application write directly to the screen (video buffer)? 

Many standard applications write directly to the screen instead of using 
DOS or other system conventions to display information (such as ANSI 
calls). These applications cannot run in a window. You must select the 
Directly Modifies screen option if your application writes to the screen. 

• Does the application display graphics? 

Standard applications that display bit-mapped graphiCS (not character­
based) write directly to the screen and cannot run in a window. 
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• Does the application provide an installation option for running under 
different screen conventions? 

Standard applications that support ANSI screen drivers can run in a win­
dow. 

• How much memory does the application require? 

If the memory requirements of the standard application and 
MS-Windows together exceed the amount of available memory, the 
application cannot run in a window. MS-Windows "steps aside" and 
gives the application the maximum amount of memory available. 

• Does the application use the alarm? 

Applications that use the alarm function of the real-time clock must run 
outside MS-Windows. At the minimum, you should select the Directly 
Modifies keyboard option. 

For standard applications that run in a window, MS-Windows does not 
support the following ANSI escape sequences: 

Cursor Position Report 

Set Mode 

- Keyboard Reassignment 

Set Graphics Renditions subsets: 

Faint on 
Italic on 
Rapid blink on 
Subscript 
Su perscri pt 

Select the Directly Modifies screen option in the PIF for any application 
that uses these. 

To experiment, run the application without setting the Directly Modifies 
screen option. If the application writes information outside its window, or 
you see unexpected results on the screen, edit the PIF and select the Directly 
Modifies screen option. 
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Changing PIFs 

Generally, you do not have to change the information in the PIFs. However, 
to change any parameters for a particular application by editing a PIF, you 
can tailor the performance characteristics of its application. 

For example, to give Lotus 1-2-3 the maximum amount of available memory 
in your workstation, change the amount in the KB Required and KB Desired 
options to 640K bytes and select None for the Screen Exchange option and 
Prevent for the Program Switch option. Close all other applications except 
for the MS-DOS Executive, then run the application. 

Some applications provide an option to install and run the application with 
an ANSI device driver (ANSI.SYS). If the application offers this option, you 
can usually run it in a window. 

Since the application can now run in a window, you must alter the PIF. You 
should cancel the Directly Modifies Screen option. (Do this for all related 
.COM or .EXE files included in the application.) 

If you run an application, and it does not load properly or is not operating as 
expected, check your PIF settings. You may need to increase the memory 
requirements of the application. 

Giving Applications More Memory 

When you run a standard application, MS-Windows allocates memory based 
on the settings in the PIF of the application. MS-Windows allocates memory 
for screen exchange (copying the screen) and for program switching (switch­
ing between the application and MS-Windows). 

You can reduce the memory requirements for an application by selecting 
options that require less memory: 

• The Screen Exchange Text option 

• The Screen Exchange None and the Program Switch Prevent options 
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AppendixD 
Using a Keyboard With 

the VT220 Emulator 

This appendix covers in table format the keys that can be used with the 
VT220 emulator. It is assumed that you know: 

• How to use MS-Windows keyboard techniques 

• The purpose of the actions you want to take as explained in the VT220 
emulator chapters 

Table D-I lists the keys used with the VT220 emulator and their functions. 

NOTE 
To access and use the arrow keys with the VT220 emulator you 
must press the Alt/spacebar keys. The first time you press this key 
combination, you get the Set-Up System menu. To access the arrow 
keys, type this key combination a second time. 

Table D-I Keys and Their VT220 Emulator Functions 

Key VT220 Emulator Function 

AIt/right arrow 
AIt/left arrow 

Alt/spacebar 

AIt/up arrow 
AIt/down arrow 

Next 

When used after pressing Alt/spacebar, it moves the high­
light right or left to the next Set-Up settings. 

The first time you use this key combination, you get the 
Set-Up System menu. To access the arrow keys, type the 
key combination a second time. 

Moves the highlight up or down within a Set-Up drop­
down menu. 

Used in Set-Up to display the next Set-Up screen from the 
menu at the top of the screen. 
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11111 Using a Keyboard With the VT220 Emulator 

Table D-l Keys and Their VT220 Emulator Functions (cont.) 

Key VT220 Emulator Function 

Prev Used in Set-Up to display the previous Set-Up screen from 
the menu at the top of (he screen. 

Right arrow Moves the cursor right or left in the tab column display. 
Left arrow 

F3 (Set-Up) Enters or exits Set-Up. 

Up arrow Sets or resets a tab stop in Set-Up. 
Down arrow 

D-2 



AppendixE 
Special Key 

Actions for MS-Paint 

This appendix describes how to use the Ctrl and Shift keys with the mouse to 
enhance or restrict some of MS-Paint's functions. 

Using the Ctrl Key: Copying a Selection 

To copy a selection with the Ctrl key: 

1. Hold down the Ctrl key. 

2. Drag the selection. 

MS-Paint creates a copy of the selection; the original remains in place. 

Using the Shift Key: Creating Multiple Copies 

To make multiple copies with the Shift key: 

1. Hold down the Shift key. 

2. Drag a selection. 

MS-Paint makes copies of the selection where the mouse cursor was dragged. 

Using the Shift Key: Scrolling a Zoomed-In Canvas 

To scroll a zoomed-in canvas with the Shift key: 

1. Hold down the Shift key in the zoomed-in drawing window. 

2. Drag. 

MS-Paint scrolls the canvas. 
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AppendixF 
Using MS-Paint 

With the Keyboard 

This appendix describes how you can use the keyboard to: 

• Select tools and shapes 

• Draw lines and shapes 

• Draw curves 

• Draw polygons 

• Use the fill tool 

• Make selections 

• Move selections 

• Copy and move selections 

• Make multiple copies of a selection 

• Scroll 

• Zoom in, zoom out, and erase by using the Return key 

You must select the proper tool before performing the sequence. 
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11111 Using MS·Paint With the Keyboard 

Selecting Tools and Shapes 

To select from the tools and shapes palette, press (Tab/Shilt/Tab ) . 

To move the highlight and select a tool or shape, you can also hold down the 
Shift/etr! keys and press an arrow key. 

Drawing Lines and Shapes 

To draw with the Pencil, Line, Freehand Polygon, Brush, Air Brush, 3-D, and 
Shapes tools: 

1. Hold down the spacebar. 

2. Press an arrow key in the direction you want to draw. 

3. Release the spacebar to finish drawing. 

Drawing Curves 

To draw a curve: 

1. Hold down the spacebar. 

2. Press an arrow key in the direction you want to draw. 

3. Move the cursor to one side of the line, and press the spacebar to mark 
the peak of the curve. 

4. Release the spacebar to draw the curve. 

Drawing Polygons 

To draw a polygon: 

1. Mark each corner with the spacebar and the arrow keys. 

MS·Paint draws the lines, connecting each corner. 

2. Press the Return key at the final corner to close the polygon. 

F-2 



Using MS-Paint With the Keyboard IIIII 

Using the Fill Tool 

To fill a shape: 

1. Press an arrow key to move the cursor over the shape. 

2. Press the spacebar. 

The interior is filled. 

Making a Selection 

To select an area of the canvas: 

1. Hold down the spacebar. 

2. Press the arrow keys to indicate the area to be selected. 

3. Release the spacebar. 

Moving a Selection 

To move a selection: 

1. Press an arrow key to move the cursor into the Selection Rectangle or 
netted area. 

2. Hold down the spacebar. 

3. Press an arrow key until the selection is moved where you want it. 

Copying and Moving a Selection 

To move a copy of a selection: 

1. Hold down Ctrl/spacebar. 

2. Press an arrow key. 
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Making Multiple Copies 

To make multiple copies of a selection: 

1. Hold down Shift/spacebar. 

2. Press an arrow key to move the selection. 

Multiple copies are made where the arrow key moves. 

Scrolling 

To scroll the screen: 

1. Hold down the spacebar. 

2. Press an arrow key. 

To scroll a zoomed-out canvas: 

1. Hold down the spacebar. 

2. Press an arrow key to move the outline of the drawing window. 

When you return to the regular drawing window, the outlined selection 
of canvas is displayed. 

To scroll the canvas under a zoomed-in drawing window: 

1. Hold down Shift/spacebar. 

The Scroll cursor replaces the Pencil cursor during the scrolling action. 

2. To scroll the canvas, move the Scroll cursor by pressing the arrow keys. 
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Using MS·Paint With the Keyboard IIIII 

Using the Return Key 

You can use the Return key to zoom in, zoom out, and erase. 

Zooming In 

To zoom in: 

I. Select the Pencil tooL 

2. Press the spacebar to mark the target area lor editing. 

3. Press the Return key to zoom in for editing. 
, 

4. Press the Return key again to return to the regular drawing window. 

Zooming Out 

To zoom out: 

1. Follow the procedures for scrolling and press the Return key. 

2. Press the Return key again to return to the regular drawing window. 

Erasing 

To erase the entire drawing window: 

1. Select the Eraser tooL 

2. Press the Return key. 
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